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Safety

This chapter includes:

INOLICES AN SAFELY ...ttt sa s ssssss s s st ss bbb st e b a st st bass s s st s s bas 10
ELECEMICAL SAFOLY ..ottt s s s s s st bbb st s s s s s s ssanes 11
OPEIALIONAL SAFELY ..ottt ss st ss s sss s s s sss s s s st s s s s s s s ssssasseses 13
MAINEENANCE SAFELY ..ottt sse s sss s e s s s s s s s s sss s s s b s bbb s b s s b s s bass s senes 15
PIINEEE SYMIDOIS ...ttt s s s bbb s s s s s 16
Environmental, Health, and Safety Contact INfOrmation ... sessssssssssenns 18

Your printer and the recommended supplies have been designed and tested to meet strict safety
requirements. Attention to the following information ensures the continued safe operation of your
Xerox printer.
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Safety

Notices and Safety

Read the following instructions carefully before operating your printer. Refer to these instructions to
ensure the continued safe operation of your printer.

Your Xerox® printer and supplies are designed and tested to meet strict safety requirements. These
include safety agency evaluation and certification, and compliance with electromagnetic regulations
and established environmental standards.

The safety and environment testing and performance of this product have been verified using Xerox®

materials only.

Note: Unauthorized alterations, which can include the addition of new functions or connection of
external devices, can affect the product certification. For more information, contact your Xerox
representative.
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Safety

Electrical Safety

This section includes:

O GONETAL GUILEIINES. ...ttt se s e e eee e tetesesesas s s asas e sesatesaenessssasasassetetesessasasasasasssassasasasasasnensasassenne 11
O POWET CONA ettt e e teeae e sesas st s ssssssssesas s sessas st s assas s s sasasaesasasastasssassasasaesasasssasssssasassasasnsssasan 12
®  EMErGENCY TUIMN Offucceeeeeeee ettt a st sas s ass bbb bbb s b e s bas b sasssnsee 12

General Guidelines

/N WARNINGS:
e Do not push objects into slots or openings on the printer. Touching a voltage point or
shorting out a part could result in fire or electric shock.

e Do not remove the covers or guards that are fastened with screws unless you are installing
optional equipment and are instructed to do so. Power off the printer when performing
these installations. Disconnect the power cord when removing covers and guards for
installing optional equipment. Except for user-installable options, there are no parts that
you can maintain or service behind these covers.

The following are hazards to your safety:

e The power cord is damaged or frayed.

e Liquid is spilled into the printer.

e The printer is exposed to water.

e The printer emits smoke, or the surface is unusually hot.

e The printer emits unusual noise or odors.

e The printer causes a circuit breaker, fuse, or other safety device to activate.

If any of these conditions occur, do the following:

1. Power off the printer immediately.

2. Disconnect the power cord from the electrical outlet.
3. Call an authorized service representative.

Xerox® VersalLink® C400 Color Printer 11
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Safety

Power Cord

Use the power cord supplied with your printer.

A\

Plug the power cord directly into a properly grounded electrical outlet. Ensure that each end of the
cord is connected securely. If you do not know if an outlet is grounded, ask an electrician to check
the outlet.

WARNING: To avoid risk of fire or electrical shock, do not use extension cords, power strips, or
power plugs for more than 90 days. When a permanent outlet receptacle cannot be installed,
use only one factory-assembled extension cord of the appropriate gauge for each printer or
multifunction printer. Always adhere to national and local building, fire, and electrical codes
regarding length of cord, conductor size, grounding, and protection.

Do not use a ground adapter plug to connect the printer to an electrical outlet that does not have
a ground connection terminal.

Verify that the printer is plugged into an outlet that is providing the correct voltage and power.
Review the electrical specification of the printer with an electrician if necessary.

Do not place the printer in an area where people can step on the power cord.

Do not place objects on the power cord.

If the power cord becomes frayed or worn, replace it.

To avoid electrical shock and damage to the cord, grasp the plug when unplugging the power cord.

The power cord is attached to the printer as a plug-in device on the back of the printer. If it is necessary
to disconnect all electrical power from the printer, disconnect the power cord from the electrical outlet.

Emergency Turn Off

If any of the following conditions occur, power off the printer immediately and disconnect the power
cord from the electrical outlet. Contact an authorized Xerox service representative to correct the
problem if:

12

The equipment emits unusual odors or makes unusual noises.

The power cable is damaged or frayed.

A wall panel circuit breaker, fuse, or other safety device has been tripped.
Liquid is spilled into the printer.

The printer is exposed to water.

Any part of the printer is damaged.

Xerox® VersalLink® C400 Color Printer
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Operational Safety

Your printer and supplies were designed and tested to meet strict safety requirements. These include
safety agency examination, approval, and compliance with established environmental standards.

Your attention to the following safety guidelines helps to ensure the continued, safe operation of
your printer.

Operational Guidelines

e Do not remove any trays while the printer is printing.

e Do not open the doors when the printer is printing.

e Do not move the printer while is printing.

e Keep hands, hair, neckties, and so on away from the exit and feed rollers.

e  Covers, which require tools for removal, protect the hazard areas within the printer. Do not remove
the protective covers.

e Do not override any electrical or mechanical interlock devices.

e Do not attempt to remove paper that is jammed deeply inside the product. Switch off the product
promptly and contact your local Xerox representative.

/1 WARNING: The metallic surfaces in the fuser area are hot. Always use caution when removing
paper jams from this area and avoid touching any metallic surfaces.

Ozone Release

This printer produces ozone during normal operation. The amount of ozone produced is dependent on
copy volume. Ozone is heavier than air and is not produced in amounts large enough to harm anyone.
Install the printer in a well-ventilated room.

For more information in the United States and Canada, go to www.xerox.com/environment. In other
markets, please contact your local Xerox representative or go to www.xerox.com/environment_europe.

Xerox® VersalLink® C400 Color Printer 13
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Safety

Printer Location

Place the printer on a level, solid, non-vibrating surface with adequate strength to hold its weight.
To find the weight for your printer configuration, refer to Physical Specifications on page 172.

Do not block or cover the slots or openings on the printer. These openings are provided for
ventilation and to prevent overheating of the printer.

Place the printer in an area where there is adequate space for operation and servicing.
Place the printer in a dust-free area.

Do not store or operate the printer in an extremely hot, cold, or humid environment.

Do not place the printer near a heat source.

Do not place the printer in direct sunlight to avoid exposure to light-sensitive components.

Do not place the printer where it is directly exposed to the cold air flow from an air
conditioning system.

Do not place the printer in locations susceptible to vibrations.
For optimum performance, use the printer at the elevations specified in Elevation on page 174.

Printer Supplies

14

Use the supplies designed for your printer. The use of unsuitable materials can cause poor
performance and a possible safety hazard.

Follow all warnings and instructions marked on, or supplied with, the product, options, and supplies.
Store all consumables in accordance with the instructions given on the package or container.

Keep all consumables away from the reach of children.

Never throw toner, toner cartridges, drum cartridges, or waste cartridges into an open flame.

When handling cartridges, for example toner and such, avoid skin or eye contact. Eye contact can

cause irritation and inflammation. Do not attempt to disassemble the cartridge, which can increase
the risk of skin or eye contact.

CAUTION: Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service
Agreement, and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation
of performance caused by use of non-Xerox supplies, or the use of Xerox supplies not specified
for this printer. The Total Satisfaction Guarantee is available in the United States and Canada.
Coverage could vary outside these areas. Please contact your Xerox representative for details.
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Maintenance Safety

Do not attempt any maintenance procedure that is not specifically described in the documentation

supplied with your printer.

e  Clean the device with a dry lint-free cloth only.

e Do not burn any consumables or routine maintenance items. For information on Xerox® supplies
recycling programs, go to www.xerox.com/gwa.

/1, WARNING: Do not use aerosol cleaners. Aerosol cleaners can be explosive or flammable when
used on electromechanical equipment.

When installing the device in a hallway or similar restricted area, additional space requirements can
apply. Ensure that you comply with all workspace safety regulations, building codes, and fire codes for

your areaq.
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Safety

Printer Symbols

Symbol Description

Warning:
& Indicates a serious hazard that can result in death or serious injury if not avoided.

Hot Warning:
Hot surface on or in the printer. Use caution to avoid personal injury.

Warning: Moving parts. To avoid personal injury, use caution.

Caution:
Indicates a mandatory action to take in order to avoid damage to the property.

A
A
o

Caution:

To avoid damage to the property, be careful not to spill toner when handling the
waste cartridge.

Do not touch the part or area of the printer.

Do not expose the drum cartridges to direct sunlight.

Do not burn the toner cartridges.

Do not burn the waste cartridge.

Do not burn the drum cartridges.
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Symbol Description

Do not use paper attached with staples or any form of binding clip.

Do not use folded, creased, curled, or wrinkled paper.

Do not use inkjet paper.

Do not use transparencies or overhead projector sheets.

Do not reload paper previously printed on or used.

Do not copy money, revenue stamps, or postage stamps.

For details about all the printer symbols that appear on your printer, refer to the Printer Symbols guide at
www.xerox.com/office/VLC400docs.
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Safety

Environmental, Health, and Safety
Contact Information

For more information on Environment, Health, and Safety in relation to this Xerox product and supplies,
contact the following customer help lines:

United States and Canada: 1-800-ASK-XEROX (1-800-275-9376)
Europe: +44 1707 353 434

For product safety information in the United States and Canada, go to www.xerox.com/environment.

For product safety information in Europe, go to www.xerox.com/environment_europe.
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Parts of the Printer

This section includes:
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Front View

. Control Panel

Tray 1 5
Bypass Tray 6. Output Tray

Front Door 7. Right- Side Door

USB Memory Port 8. Tray 2, Optional 550-Sheet Feeder

BN -
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Internal Parts

4. Waste Cartridge Lock
5. Drum Cartridges
6. Waste Cartridge

Front Door
2. Toner Cartridges

1.

3. Transfer Belt Assembly

Rear View
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7. Wireless Network Adapter Port Cover

8. USB Port, Type A
9. USB Port, Type B

10.Ethernet Port

Duplex Unit
2. Transfer Roller
3. Fuser

1.

4. Power Connector

5. Rear Door

11.Foreign Device Interface Connector

6. Left Side Cover
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Control Panel

The control panel consists of a touch screen and buttons you press to control the functions available on
the printer. The control panel:

e Displays the current operating status of the printer.

e  Provides access to printing features.

e Provides access to reference materials.

e Provides access to Tools and Setup menus.

e  Prompts you to load paper, replace supplies, and clear jams.
e Displays errors and warnings.

e  Provides the Power/Wake button used for powering on or off the printer. This button also supports
the power-saver modes, and blinks to indicate the power status of the printer.
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Name

NFC Area

Getting Started

Description

Near Field Communication (NFC), is a technology that enables devices to
communicate when they are within 10 cm (4 in.) of each other. Use the NFC
area to obtain a network interface or to establish a TCP/IP connection
between your device and the printer.

Touch Screen Display

The screen displays information and provides access to printer functions.

Home Button

This button provides access to the Home menu for access to printer features.

Power/Wake

This button serves several power-related functions.

When the printer is powered off, this button powers on on the printer.

When the printer is powered on, pressing this button displays a menu on
the control panel. From this menu, you can choose to enter Sleep mode,
restart, or power off the printer.

When the printer is powered on, but in a low-power mode or Sleep mode,
pressing this button wakes the printer.

When the printer is powered on, holding this button for 10-seconds turns
off the printer.

This button also blinks to indicate the power status of the printer.

When the light blinks slowly, the printer is in low-power mode or
Sleep mode.

When the light blinks rapidly, the printer is powering down, or exiting a
low-power mode.

Status LED

This light blinks blue or amber to indicate printer status.
Blue

Blinks blue once to acknowledge a successful Authentication request.
Blinks blue once slowly for a print job initiated at the control panel.
Blinks blue twice slowly for a print job received from the network.

Blinks blue rapidly while the printer is powering up, or to signal detection of
a Wi-Fi Direct connection request.

Amber

Blinks amber to indicate an error condition or warning that requires your
attention. For example, an out-of-toner condition, a paper jam, or out of
paper for the current job.

It also blinks amber to indicate a system error, which typically is associated
with an error code.

Notification Banner

Notifications and messages are displayed in a pop-up banner below the apps
area. To view the full notification, touch the down arrow. Once you have
reviewed the information, touch X to close.

Pause Button

When a job is being processed, a Pause icon appears in the notification banner
area. To pause the current job, touch the Pause icon. The job pauses with the
option to resume or delete the job.
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Power Options

The Power/Wake button is a single multifunction button on the control panel.
e  When used in conjunction with the power switch, the Power/Wake button powers on the printer.
e If the printer is already powered on, the Power/Wake button can be used to:
— restart the printer
—  enter or exit sleep mode
—  enter or exit low-power mode
e The Power/Wake button also flashes when the printer is in low-power mode.

Powering On the Printer or Exiting Low-Power or Sleep Mode

To power on the printer, or to exit Low-Power mode or Sleep mode, press the Power/Wake button.

Notes:

e The Power/Wake button is the only power button on the printer.

e The printer exits Low-Power mode or Sleep mode automatically when it receives data from a
connected device.

e  When the printer is in Low-Power mode, or Sleep mode, the touch screen is blank and
unresponsive. To wake the printer manually, press the Power/Wake button.

/1, CAUTION: Do not plug or unplug the power cord while the printer is powered on.
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Restarting, Placing in Sleep Mode, or Powering Off the Printer
1. At the printer control panel, press the Power/Wake button.

2. Select an option.
—  Torestart the printer, touch Restart.
—  To place the printer in Sleep Mode, touch Sleep.
In Sleep Mode, the touch screen goes dark and the Power/Wake button flashes.
—  To power off the printer, touch Power Off.

—  If the printer does not respond to a single press of the Power/Wake button, then press and
hold the button for 5 seconds. A Please Wait message appears as the printer powers down.

After 10 seconds, the touch screen goes dark and the Power/Wake button flashes until the
printer powers down.

&_ CAUTION: Do not unplug the power cord while the printer powers down.
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Accessing the Printer

Logging In

Logging in is the process by which you identify yourself to the printer for authentication.
If authentication is set, to access printer features, you log in with your user credentials.

Logging In at the Control Panel

1.

i whN

26

At the printer control panel, press the Home button.
Touch Log In.

Type the User Name using the keypad, then touch Enter.
If prompted, enter the password, then press Enter.
Touch OK.

Note: To access each service that is password-protected, repeat steps 3 and 4.
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Introduction to Apps

Xerox Apps are a gateway to the features and functions of your device. There are standard Apps that
are already installed on the device and that appear on the Home screen. There are also Apps that are
installed as standard but are hidden when your device is used for the first time.

When you log in, the apps that are configured for your personal account appear on the control panel.

You can download more Apps for your device from the Xerox® App Gallery. For details, refer to Xerox
Apps Gallery Overview on page 54.
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Information Pages

Your printer has a set of information pages that you can print. These pages include configuration and
font information, demonstration pages, and more.

The following Information Pages are available:

Z

Q
‘

)

Configuration Report

Description

The Configuration Report provides printer information including
installed options, network settings, port setup, tray information, and
more.

Billing Summary Report

The Billing Summary Report provides information about the device
and a detailed listing of the billing meters and sheet counts.

Supplies Usage Report

The Supplies Usage Report provides coverage information and part
numbers for reordering supplies.

PostScript Font List

The PostScript Font List provides a printout of all PostScript fonts
that are available on the printer.

PCL Font List

The PCL Font List provides a printout of all PCL fonts that are
available on the printer.

Demonstration Print

Demonstration Print provides a demonstration of the current print
quality.

Startup Page

The Startup Page provides basic printer configuration and network
information.

Job History Report

RN EECOEE

The printer retains information on previous print jobs, including the
date, time, job type, document name, output color, paper size,
number of pages, and results. The status of a maximum of 20 jobs
prints on the Job History Report.

Printing Information Pages

At the printer control panel, press the Home button.

Touch Device > About > Information Pages.

1
2
3. To print an information page, touch the desired page.
4

To return to the Home screen, press the Home button.
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Configuration Report

The Configuration Report provides product information including, installed options, network settings,
port setup, tray information, and more.

Printing the Configuration Report

1. Atthe printer control panel, press the Home button.

2. Touch Device > About > Information Pages.

3.  Touch Configuration Report.

4. Toreturn to the Home screen, press the Home button.
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The Embedded Web Server

The Embedded Web Server is the administration and configuration software that is installed in the
printer. It allows you to configure and administer the printer from a Web browser.

The Embedded Web Server requires:

e  ATCP/IP connection between the printer and the network in Windows, Macintosh, UNIX, or
Linux environments.

e  TCP/IP and HTTP enabled in the printer.
e A network-connected computer with a Web browser that supports JavaScript.

Accessing the Embedded Web Server

At your computer, open a Web browser. In the address field, type the IP address of the printer, then press
Enter or Return.

Finding the IP Address of Your Printer

To install the print driver for a network-connected printer, you need the IP address of your printer.
You also need the IP address to access the settings of your printer through the Embedded Web Server.
You can view the IP address of your printer on the control panel or on the Configuration Report.

Note: Wait until the printer has been on for 2 minutes to view the TCP/IP address. If the TCP/IP address
is 0.0.0.0, or begins with 169, it indicates a network connectivity issue.

To view the IP address of the printer on the control panel:
1. At the printer control panel, press the Home button.
2. Touch Device > About.

3. Record the IP address from the display.

4. To return to the Home screen, press the Home button.

To obtain the printer IP address from the Configuration Report:
1. At the printer control panel, press the Home button.
2. Touch Device > About > Information Pages.

3. Touch Configuration Report. The IP address appears in the Connectivity section of the
Configuration Report for IPv4 or IPv6.

To return to the Home screen, press the Home button.
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Installation and Setup

For reference:
Installation Guide packaged with your printer.
Online Support Assistant at www.xerox.com/office/VLC400support

Installation and Setup Overview

Before you print, ensure that your computer and the printer are plugged in, powered on, and connected.
Configure the initial settings of the printer, then install the print driver software and utilities on
your computer.

You can connect to your printer directly from your computer using USB, or connect to a network using
an Ethernet cable or wireless connection. Hardware and cabling requirements vary for the different
connection methods. Routers, network hubs and switches, modems, Ethernet cables, and USB cables are
not included with your printer and are purchased separately. Xerox recommends an Ethernet connection
because it is typically faster than a USB connection, and it provides access to the Embedded Web Server.

For more information, refer to the System Administrator Guide at www.xerox.com/office/VLC400docs.

Selecting a Location for the Printer

1. Select a dust-free area with temperatures from 10-32°C (50-90°F), and relative humidity 10-85%.

Note: Sudden temperature fluctuations can affect print quality. Rapid heating of a cold room can
cause condensation inside the printer, directly interfering with image transfer.

2. Place the printer on a level, solid, non-vibrating surface with adequate strength to hold the weight
of the printer. The printer must be horizontal with all four feet in solid contact with the surface.
To find the weight for your printer configuration, refer to Weights and Dimension on page 172,
on page 172. Select a location with adequate clearance to access supplies and to provide proper
ventilation. To find the clearance requirements for your printer, refer to Clearance Requirements
on page 173.

3. After positioning the printer, you are ready to connect it to the power source and computer
or network.
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Connecting the Printer

This section includes:
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Connecting t0 A WiIr@d NETWOTK ...ttt s ssssssssssssssssssssssssssessssssssssssssssssnsesssssnns 33
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Selecting a Connection Method

You can connect the printer to your computer using a USB cable, Ethernet cable, or wireless connection.
The method that you select depends on how your computer is connected to the network. A USB
connection is a direct connection and is the easiest to set up. An Ethernet connection is used to connect
to a network. If you are using a network connection, it is important to understand how your computer is
connected to the network.

Note: Hardware and cabling requirements vary for the different connection methods. Routers, network
hubs, network switches, modems, Ethernet cables, and USB cables are not included with your printer and
must be purchased separately.

32

USB: If you connect the printer to one computer and do not have a network, use a USB connection.
A USB connection offers fast data speeds, but typically not as fast as a network connection.

Note: To access the Embedded Web Server, a network connection is required.

Network: If your computer is connected to an office network or home network, use an Ethernet
cable to connect the printer to the network. You cannot connect the printer directly to the computer.
A conncetion through a router or network switch is required. An Ethernet network can be used for
one or more computers and supports many printers and systems simultaneously. An Ethernet
connection is typically faster than USB and allows you direct access to the settings of the printer
using the Embedded Web Server.

Wireless Network: If your environment includes a wireless router or wireless access point, you can
connect the printer to the network with a wireless connection. A wireless network connection
provides the same access and services as a wired connection provides. A wireless network
connection is typically faster than USB and allows direct access to the settings of the printer
using the Embedded Web Server.
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Connecting to a Computer Using USB

Windows 7, Windows 8.1, Windows Server 2008, Windows 10, Windows Server 2008 R2, and
Windows Server 2012.

Macintosh OS X version 10.9 and later.

UNIX and Linux: Your printer supports connection to various UNIX platforms through the
network interface.

To connect the printer to the computer using a USB cable:

1.

2.
3.
4,

Connect the B end of a standard A/B USB 2.0 or USB 3.0 cable to the USB Port on the back of
the printer.

Connect the A end of the USB cable to the USB port on the computer.
If the Windows Found New Hardware Wizard appears, cancel it.
Install the print driver.

For more information, refer to Installing the Software on page 41.

Connecting to a Wired Network

1.
2.

Ensure that the printer is powered off.

Attach a Category 5 or better Ethernet cable from the printer to the network or router socket.
Use an Ethernet switch or router, and two or more Ethernet cables. Connect the computer to the
switch or router with one cable, then connect the printer to the switch or router with the second
cable. Connect to any port on the switch or router except the uplink port.

Attach the power cord, then plug in the printer and turn it on.

Set the network IP printer address, or set up the printer for automatic printer IP detection. For more
information, refer to the System Administrator Guide at www.xerox.com/office/VLC400docs.
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Connecting to a Wireless Network

A wireless local area network (WLAN) provides the means to connect two or more devices in a LAN
without a physical connection. The printer can connect to a wireless LAN that includes a wireless router
or wireless access point. Before connecting the printer to a wireless network, the wireless router must be
configured with a service set identifier (SSID) and any necessary credentials.

Note: Wireless networking is available only on printers with the optional Wireless Network
Adapter installed.

Installing the Wireless Network Adapter

The optional wireless network adapter plugs in to the back of the control board. After the adapter is
installed, and wireless networking is enabled and configured, the adapter is able to connect to a
wireless network.

To install the Wireless Network Adapter:
1.  Power off the printer.

2. Toremove the Wireless Network Adapter Port Cover, press the latch to the left, then pull the cover
away from the printer.

T
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3. Remove the packaging from the Wireless Network Adapter.

4, Toinstall the Wireless Network Adapter, follow the procedure defined on the instruction sheet
provided with the Wireless Network Adapter.

gy

111111111110

&

/1, CAUTION: Pulling on the adapter can cause damage. After the adapter is installed, remove it only
as needed, and as directed in the Wireless Network Adapter removal instructions. For details, refer
to Removing the Wireless Network Adapter.

5.  Power on the printer.

Configure the Wi-Fi Settings. For details about configuring the Wi-Fi settings, refer to the System
Administrator Guide at www.xerox.com/office/VLC400docs.

Removing the Wireless Network Adapter
1. Power off the printer.
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2. Loosen the bolt that secures the left-side cover.

prg
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3. Toopen the cover, slide it toward the rear of the printer, then away from the printer.

4. Reach into the printer and pull the release lever. Grasp the Wireless Network Adapter with your
other hand and carefully pull it away from the printer.

/1, CAUTION: Do not use force to pull on the Wireless Network Adapter. If the latch is released
properly, the adapter pulls out easily. Pulling on a secured adapter can damage it.
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5. Toreinstall the Wireless Network Adapter Port Cover, insert the tab into the small slot. Gently press
the port cover against the back of the printer until the cover latches into place.

6.

7.

prmg
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8. Connect the printer to your computer with a USB cable or through the network using an
Ethernet cable.

i
PN

&,

o

9. Power on the printer.

Note: If the printer was installed previously in a wireless network environment, it could retain setup and
configuration information from that environment. To prevent the printer from attempting to connect to
the previous network, reset the wireless settings. For more information, refer to the System Administrator
Guide at www.xerox.com/office/VLC400docs.

Connecting to Wi-Fi Direct

You can connect to your printer from a Wi-Fi mobile device, such as a tablet, computer, or smart phone,
using Wi-Fi Direct. Wi-Fi Direct is disabled by default. For details, refer to Configuring Wi-Fi Direct.

Note: Wireless networking is available only on printers with the optional Wireless Network
Adapter installed.

Connecting with Wi-Fi Direct from Your Mobile Device

To connect with Wi-Fi Direct, follow the directions provided with your mobile device.
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Initial Printer Setup

Before installing the printer software, verify that the printer is set up correctly. Setup includes enabling
the optional features and assigning an IP address for the Ethernet network connection. The installation
wizard starts automatically the first time the printer is started. The installation wizard prompts the
System Administrator to configure the following settings:

e Language

e Network Connection
e  Proxy Server Setup

e Dateand Time

e  Measurements

e  LDAP Settings

e  Apps Setup

e  Security Settings

For more information on configuring the printer settings, refer to the System Administrator Guide at
www .xerox.com/office/VLC400docs.

Configuring AirPrint

AirPrint is a software feature that allows you to print from wired or wireless Apple iOS-based mobile
devices and Mac OS-based devices without the need to install a print driver. AirPrint-enabled printers
allow you to print directly from a Mac, an iPhone, iPad, or iPod touch. You can use AirPrint to print from
a wired device or a wireless device without using a print driver.

y——

AirPrint

Notes:

e Not all applications support AirPrint.
e  Wireless devices must join the same wireless network as the printer.
e  For AirPrint to function, both IPP and Bonjour (mDNS) protocols must be enabled.

e The device that submits the AirPrint job must be on the same subnet as the printer. To allow
devices to print from different subnets, configure your network to pass multicast DNS traffic
across subnets.

e  The Mac OS device must be Mac OS 10.7 or later.
e AirPrint-enabled printers work with all models of iPad, iPhone (3GS or later), and iPod touch
(3rd generation or later), running the latest version of iOS.
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then
press Enter or Return.

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your
Printer on page 30.

Xerox® VersalLink® C400 Color Printer 39
User Guide


http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLC400&PgName=Man&Language=English

Getting Started

2. Inthe Embedded Web Server, click Home > Connectivity.
Note: If this feature does not appear, log in as a system administrator.

3. For Mobile Printing, click AirPrint™.
4. To enable AirPrint™, click the Enable toggle button.

Note: AirPrint™ is enabled by default when IPP and Bonjour (mDNS) are both enabled.

— Tochange the printer name, in the Name field, enter a new name.
— Toenter alocation for the printer, in the Location field, enter the location of the printer.

— Toenter a physical location or address for the printer, in the Geo-Location field, enter the
geographic latitude and longitude coordinates in decimal form. For example, use coordinates
such as 45.325026, -122.766831 for a location.

Click OK.
6. To activate your changes, at the prompt, click Restart Now.

v

Google Cloud Print

Google Cloud Print allows you to print documents that are stored in the cloud without using a
print driver.

Before you begin:

e Set up a Google email account.

e Configure the printer to use IPv4.

e  Configure Proxy Server settings as needed.

To configure Google Cloud Print:
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then
press Enter or Return.

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your
Printer on page 30.

2. Inthe Embedded Web Server, click Home > Connectivity.
3. For Mobile Printing, click Google Cloud Print.
4. To enable Google Cloud Print, click the Enable toggle button.
5. Click OK.
6. Restart the printer, then wait two minutes for the printer to connect.
7. Refresh your Web browser, then for Mobile Printing, click Google Cloud Print.
8. Click Printer Registration.
9. Click Register.
A printer registration page prints.
10. To register the printer, in your Web browser, type the URL provided, or use your mobile phone to

scan the barcode.
Once the printer is registered, the word Registered appears in the printer status.
11. To access the Google Cloud Print feature, in your Google account, click Manage Your Printer.

Note: The default printer name appears in this format: Model name (MAC address).
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Installing the Software

This section includes:
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o Installing the Printer as a Web SErvice 0N DEVICES ......rereererineennsnssssssissssssssisssssssssssssssssssssssssssssssssses 44

Before installing driver software, verify that the printer is plugged in, turned on, connected correctly, and
has a valid IP address. The IP address usually appears in the upper right corner of the control panel.
If you cannot find the IP address, refer to Finding the IP Address of Your Printer on page 30.

If the Software and Documentation discis not available, download the latest drivers from
www.xerox.com/office/VLC400drivers.

Operating System Requirements

e  Windows Vista, Windows 7, Windows 8.1, Windows Server 2008, Windows 10, Windows Server 2008
R2, and Windows Server 2012.

e  Macintosh OS X version 10.9 and later.

e  UNIX and Linux: Your printer supports connection to various UNIX platforms through the
network interface.

Installing the Print Drivers for a Windows Network Printer

1. Insert the Software and Documentation discinto the appropriate drive on your computer. If the
installer does not start automatically, navigate to the drive, and double-click the Setup.exe
installer file.

Select your printer model.

Click Install Drivers.

Select Install Print Driver.

At the License Agreement, click I Agree.

ok whN

From the list of discovered printers, select your printer.

Note: When installing drivers for a network printer, if your printer does not appear in the list, click
the IP Address or DNS Name button. In the IP Address or DNS Name field, type the IP address of
your printer, then click Search to locate and select your printer. If you do not know the IP address of
the printer, refer to Finding the IP Address of Your Printer on page 30.

7. Click Next.

8. If desired, you can name your printer by typing a name in the Queue Name field.

9. Select a Print Driver.

10. Click Install.
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11. If desired, set the printer as the default printer.
Note: Before selecting Share Printer, contact your system administrator.

12. To complete the installation, click Finish, then click Close.

Installing the Print Drivers for a Windows USB Printer

1. Insert the Software and Documentation discinto the appropriate drive on your computer.

If the installer does not start automatically, navigate to the drive, and double-click the Setup.exe
installer file.

Click Install Software.

At the License Agreement, select I Agree, then click Next.

To install the printer support software, select Software, then click Next.

In the Software and Documentation window, clear the check box for any undesired options.
Click Next.

To complete the installation, click Finish.

No v WwWN

Installing the Drivers and Utilities for Macintosh OS X

1. Insert the Software and Documentation discinto the appropriate drive on your computer.

2. Open Xerox® Print Drivers 3.xx.x.dmg/.pkg as needed for your printer.

3. Torun Xerox® Print Drivers 3.xx.x.dmg/.pkg, double-click the appropriate file name.

4. When prompted, click Continue.

5. To accept the license agreement, click I Agree.

6. To accept the current installation location, click Install, or select another location for the installation
files, then click Install.

7. If prompted, enter your password, then click OK.

8. From the list of discovered printers, select your printer, then click Next.

9. If your printer does not appear in the list of discovered printers:
a. Click the Network Printer Icon.
b. Type the IP address of your printer, then click Continue.
c.  Select your printer in the list of discovered printers, then click Continue.

10. If your printer was not detected, verify that the printer is on and that the Ethernet or USB cable is
connected properly.

11. To accept the print queue message, click OK.
12. Select or clear the Set Printer as Default and Print a Test Page check boxes.
13. Click Continue, then click Close.
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Adding the Printer

For networking, set up your printer using Bonjour (Rendezvous), or connect using the IP address of your
printer for an LPD/LPR connection. For a non-network printer, create a desktop USB connection.

To add the printer using Bonjour:
1.
2.

From the computer Applications folder or from the dock, open System Preferences.
Click Printers & Scanners.

The list of printers appears on the left of the window.

Under the list of printers, click the plus button (+).

At the top of the window, click the Default icon.

Select your printer from the list, then click Add.

Note: If your printer was not detected, verify that the printer is on and that the Ethernet cable is
connected properly.

To add the printer by specifying the IP address:
1.
2.
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0.

From the computer Applications folder or from the dock, open System Preferences.
Click Printers & Scanners.

The list of printers appears on the left of the window.

Under the list of printers, click the plus button (+).

Click IP.

From the Protocol drop-down menu, select the protocol.

In the Address field, enter the IP address of the printer.

In the Name field, enter a name for the printer.

From the Print Using drop-down list, choose Select a driver to use.

From the printer software list, select the print driver for your printer model.
Click Add.

For reference:

Online Support Assistant at: www.xerox.com/office/VLC400support
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Installing Drivers and Utilities for UNIX and Linux

For details on installing print drivers and utilities for UNIX and Linux, refer to UNIX and Linux Printing on
page 76.

Installing the Printer as a Web Service on Devices

Web Services on Devices (WSD) allow a client to discover and access a remote device and its associated
services across a network. WSD supports device discovery, control, and use.

To install a WSD printer using the Add Device Wizard:

1. At your computer, click Start, then select Devices and Printers.

2. To launch the Add Device Wizard, click Add a Device.

3. Inthe list of available devices, select the one you want to use, then click Next.

Note: If the printer you want to use does not appear in the list, click the Cancel button.
Add the WSD printer manually using the Add Printer Wizard.

4. Click Close.

To install a WSD printer using the Add Printer Wizard:

At your computer, click Start, then select Devices and Printers.

To launch the Add Printer Wizard, click Add a Printer.

Click Add a network, wireless, or Bluetooth printer.

In the list of available devices, select the one you want to use, then click Next.

If the printer you want to use does not appear in the list, click The printer that I want is not listed.
Select Add a printer using a TCP/IP address or hostname, then click Next.

From the Device type field, select Web Services Device.

Enter the printer IP address in the Hostname or IP address field, then click Next.

Click Close.
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More Information

Getting Started

You can obtain more information about your printer from these sources:

Resource Location

Installation Guide

Packaged with the printer.

Other documentation for your printer

www.xerox.com/office/VLC400docs

Recommended Media List

United States: www.xerox.com/rmlna
European Union: www.xerox.com/rmleu

Technical support information for your printer;
including online technical support, Online Support
Assistant, and print driver downloads.

www.xerox.com/office/VLC400support

Information Pages

Print from the control panel. For details, refer to
Information Pages on page 28.

Order supplies for your printer

www.xerox.com/office/VLC400supplies

A resource for tools and information, including
interactive tutorials, printing templates, helpful tips,

and customized features to meet your individual needs.

www.xerox.com/office/businessresourcecenter

Local sales and Technical Customer Support

www.xerox.com/office/worldcontacts

Printer registration

www.xerox.com/office/register

Xerox® Direct online store

www.direct.xerox.com/
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Customize and
Personalize

This chapter includes:
e  Customize and Personalize Overview

e  Customizing or Personalizing the Home Screen
e  Customizing or Personalizing the Apps
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Customize and Personalize

Customize and Personalize Overview

This chapter provides information on how to customize and personalize your device to meet the specific
demands of your workflows.

[ ) You can Customize your Apps, hide, or show Apps on the Home screen, and rearrange
.Y. the order to suit your job priorities.
[ — ] |

Customization enables users to work more productively.

When individual user accounts are configured on the device, you can Personalize the
. device to meet specific user needs. You can configure your personal Home page to hide
] or show only the Apps you use.

Personalization options ensure that the functions displayed meet individual user needs,
improving efficiency.
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Customizing or Personalizing the Home Screen

To hide or show an App on the Home screen:

1.
2.
3.

5.

At the printer control panel, press the Home button.

Touch Customize.

To display an installed, but hidden App:

a. Touch +.

b. Touch the App that you want to appear on the control panel.
c¢. Touch Done.

To hide an installed App:

a. Forthe desired App, touch X.

b. Touch Done.

Verify that only the desired Apps are displayed on the Home screen.

To rearrange Apps on the Home screen:

NouvubwN-~

At the printer control panel, press the Home button.

Touch Customize.

Touch and hold the required App.

Drag the App to the new location.

Release the App.

Touch Done.

Verify that the Apps appear in the correct location on the Home screen.
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Customizing or Personalizing the Apps

Customization enables you to modify the features available, delete a saved preset, or remove
customized settings applied to an App.

Customizing or Personalizing the Feature List

To customize the Features list for an App:

1.

2.
3.
4

At the printer control panel, press the Home button.

Touch the App required.

Scroll to the bottom, then touch Customize.

Touch Feature List.

Note: For logged-in administrators, a window appears that asks you to confirm if the changes are
for a Guest or for you.

Touch the desired option.

— To hide a feature, for the required feature, touch the Eye icon. To signify that the feature is
hidden, the Eye icon appears with a line across.

— Toshow a feature, for the required feature, touch the Eye icon. To signify a feature is visible,
the Eye icon appears with no line across.

To reorder the menu features, touch and drag the features into the desired order.
To save the current configuration, touch Done.

Saving Presets

You can use this feature to save a particular combination of App settings for future jobs. You can save
the settings with a name and retrieve them for later use.

To save the current App settings:
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At the printer control panel, press the Home button.

Touch the App required.

Select the job settings.

Scroll to the bottom, then touch Save.

Touch Save as New Preset.

Touch Enter Preset Name, then to enter a preset name, use the keypad.
Touch Next.

Select an icon that best suits the preset that you are creating.

Touch Done.

Note: The preset is stored within the Preset feature.
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Deleting a Saved Preset

To delete a saved preset:

At the printer control panel, press the Home button.

Touch the App required.

Scroll to the bottom, then touch Customize.

Touch Presets.

Touch the Trash icon that corresponds with the preset that you want to delete.
At the prompt, touch Delete.

Touch Done.

No vk Wwh =

Removing App Customization

To remove the current App customization settings:

1. Atthe printer control panel, press the Home button.
Touch the App required.

Scroll to the bottom, then touch Customize.

Touch Remove App Customization.

At the prompt, touch OK.
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Xerox® Apps

This chapter includes:

©  XETOX® APP GAUETY ..ot ssseseesssssssessssssssessssssssesssssssssssssssssesssssassessssssssssssssasessssssmssesssssmssesssssnsensssses 54
° DIBVICE ettt ettt s st st se s s ettt e s s e ettt e s s ss s ettt esesensseestatesesessas sttt et eseasaeneattesensasasasatane 57
O OISttt ettt sttt et ettt e ettt ettt e a e a bttt et e e asae e ettt et e e e e seasaeaeeetetataseaeaensaees 62
O PHINE FTOM U USB ...ttt sttt st bttt s s s asassssssesasasasasasasssssssssasase 68

Xerox® Apps are a gateway to the features and functions of your device. There are standard Apps
already installed and displayed on the Home screen. There are also Apps that are installed as standard
but are hidden when your device is used for the first time.

For details about Customizing the Home screen and the Apps features, refer to Customize and
Personalize on page 47.

A range of Apps are available for download and installation from the Xerox® App Gallery. These include
Xerox® Extensible Interface Platform (EIP) Apps. EIP Apps enable you to install secure, signed apps on
compatible printers.

For more information about using the Xerox® Apps Gallery and downloading Apps, refer to Xerox Apps
Gallery on page 54.
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Xerox® App Gallery

This section includes:

XErOX® APPS GAIETY OVEIVIEW ........ooeeeeveeeeeeeeeeeeevesaseeeeseeessssssessssssssssssessssssssssssssssssssssssssssssssssssssesessssssssssesseses 54
Creating a XeroX® APP GAIEIY ACCOUNT ............ceereeeveeeeeeeeeeeeeesesssseesssssseesssssssssssssssssssssssssssssssesssssssssssssansesssses 55
Logging in to your Xerox® App GAUErY ACCOUNT .........oecveeeeeeeeeeeeeeeeeeseeesessssssesssssssessssssssessssssssssssssssesssssaenee 56
Installing or Updating an App from the Xerox® App GAUErY ..........ceevweeceeeeeeeeeeeveesseeeeeeesssssseeesesssssnnns 56

Xerox® Apps Gallery Overview

Use the Xerox® App Gallery to find Apps that provide new features or capabilities for
your device. The Xerox® App Gallery allows you direct access to Apps that can improve
your productivity, simplify workflows, and enhance your user experience.

To use the Xerox® App Gallery App, ensure that your device uses either the wireless or the wired
network connection.

Note: If your device is hosted by a local server inside a firewall and a proxy is enabled, set a proxy
exception at the device.

For further information and instructions on using the Xerox® App Gallery, refer to the Xerox® App Gallery
User Guide available at www.xerox.com.

54
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Xerox® Apps

Creating a Xerox® App Gallery Account

With an App Gallery account, you have direct access to all the available Apps for your device. An App
Gallery account allows you to view and acquire Apps, install Apps on your device, and manage your Apps
and licenses.

An App Gallery account can be setup using the control panel or the Embedded Web Server.
For information about accessing the Embedded Web Server, refer to Getting Started on page 30.

Note: If you have an existing Xerox App Gallery Account, refer to Logging in to your App Gallery Account
on page 56.

To create an App Gallery account using the Control Panel:

1.

2.
3.
4

v
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11.
12.
13.

At the printer control panel, press the Home button.
Touch Xerox App Gallery.
Touch Request an Account.

Touch the Enter your email address. Enter a valid email address using the touch screen keypad,
then touch Enter.

Touch OK. A message is displayed stating completion instructions have been sent to the email
address entered.

Touch Close.

Access your email account for the email address that you provided to Xerox App Gallery.
Open the Xerox App Gallery Account Request email, then click the URL link for creating an account.
Review and accept the Terms of Use. To continue creating an account, click the Agree button.
Enter the information required into the appropriate fields:

—  UserID

—  Password

—  Confirm Password

—  First and Last Name

—  Company Name

—  Address (Street, City, State/Province, Postal)

—  Country

Click OK.

After the account is created, a confirmation message appears.

At the printer control panel, log in to your App Gallery Account.
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Logging in to your Xerox® App Gallery Account

When you are logged in to the App Gallery, you can browse available Apps, and install and update Apps.

To log in to your App Gallery Account:

1. At the printer control panel, press the Home button.

Touch Xerox® App Gallery.

Enter your User Name using the touch screen keypad, then touch Enter.
Enter your Password using the touch screen keypad, then touch Enter.

LA

Touch Log In. The Xerox® App Gallery appears.

Installing or Updating an App from the Xerox® App Gallery

Xerox® Apps add, extend, or customize the functionality of your device. You can use the Xerox® App
Gallery App to browse and install Apps at your device control panel.

To install an App from the App Gallery:

At the printer control panel, press the Home button.

Touch Xerox® App Gallery.

Enter your User Name using the touch screen keypad, then touch Enter.
Enter your Password using the touch screen keypad, then touch Enter.
Touch Log In. The Xerox® App Gallery appears.

o bkwhN-=

Touch the App required, then touch Install. The License Agreement screen appears.

Note: If the App was installed previously and a new version is available, the button is laeled

as Update.
7. Touch Agree. The installation process begins.

If the App does not successfully install, to attempt the installation process again, touch Install.
8. To exit the Xerox® App Gallery App, touch Exit.

To update an App from the App Gallery:

At the printer control panel, press the Home button.

Touch Xerox® App Gallery.

Enter your User Name using the touch screen keypad, then touch Enter.

Enter your Password using the touch screen keypad, then touch Enter.

Touch Log In. The Xerox® App Gallery appears.

Touch the App required, then touch Update. The License Agreement screen appears.
Touch Agree.

When the update is complete, the Update button is labeled as Installed.

To exit the Xerox® App Gallery App, touch Exit.
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Device

This section includes:
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Device Overview

The Device App gives you access to information about your printer, including the serial
number and model. You can view the status of the paper trays, billing and supplies
information, and print information pages.

Many Device options can be configured to meet your individual needs. For details about configuring all
of the Device settings, refer to the System Administrator Guide at www xerox.com/office/VLC400docs.
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Device Options

The following Device options are available:

Option Description

Language Language allows you to set the language that appears on the control
panel display.
About The About option provides an overview of your device and its current settings

and status. You can access information pages and reports using this option.

Software Update Use this option to check for software updates and configure update settings.

Notifications Use the Notifications option to see details of any current alerts or faults on
the device. A History button displays fault codes and the date they occurred
on the device.

Paper Trays Use the Paper Trays option to see the paper size, type, and color set for each
paper tray and the tray-capacity status.

Supplies Use the Supplies section to monitor the status of the components you can
replace. The supply level and estimated number of impressions or days left for
each unit is displayed.

Billing/Usage Use the Billing/Usage option to view the serial number and the total number
of impressions made by your device.

General Use the General option to customize settings such as the power-save modes,
05 date and time, and control panel brightness. You can configure the General
settings using the device control panel, or by using the Embedded Web Server.
Apps Use Apps to select settings for the Apps installed on your device.
Connectivity Use the Connectivity option to configure network settings at the control

panel, or join another wireless network.

Support Use this option to access and print the Support Pages to assist with
O troubleshooting errors.
Resets Use the Resets option to reset device settings and font, forms, and macros to

the factory-default settings.

For details on configuring the printer settings, refer to the System Administrator Guide at
www.xerox.com/office/VLC400docs.
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About

The About option provides an overview of your device and its current settings and status. You can access
information pages and reports using this option.

Information Pages

Your printer has a set of information pages that you can print. These pages include configuration and
font information, demonstration pages, and more.

The following Information Pages are available:

Name

Description

Configuration Report The Configuration Report provides printer information including
installed options, network settings, port setup, tray information,
and more.

Billing Summary Report The Billing Summary Report provides information about the device

and a detailed listing of the billing meters and sheet counts.

Supplies Usage Report The Supplies Usage Report provides coverage information and part
numbers for reordering supplies.

PostScript Font List The PostScript Font List provides a printout of all PostScript fonts
that are available on the printer.

PCL Font List The PCL Font List provides a printout of all PCL fonts that are
available on the printer.

Demonstration Print Demonstration Print provides a demonstration of the current
print quality.

Startup Page The Startup Page provides basic printer configuration and

network information.

Job History Report The printer retains information on previous print jobs, including the
date, time, job type, document name, output color, paper size,
number of pages, and results. The status of a maximum of 20 jobs
prints on the Job History Report.
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Supply Status

You can check the status and percentage of life remaining for your printer supplies at the control panel
or from the Embedded Web Server. When printer supplies near their replacement time, warning alerts
appear on the control panel. You can customize the alerts that appear on the control panel and
configure email alert notifications.

To check the supplies status at the control panel:

1.
2.

3.
4,

To view status information for the printer supplies, touch Device > Supplies.

To view details about a specific item, including its part number for reordering, touch the
desired item.

To return to the Supplies screen, touch X.
To return to the Device screen, touch the back arrow.

To customize supplies alert settings:

1.
2.
3.

4,
5.
6.

To customize the alerts that appear for printer supplies, touch Device > Supplies > Alerts Setup.
To enable supplies alerts, touch the Enable Alerts toggle button.

To configure the printer to display an alert when an item reaches a specific usage percentage level,
touch the item, then select the percentage.

To customize the alerts for each supply item, to enable or disable an alert, touch the toggle button.
To return to the Supplies screen, touch X.
To return to the Device screen, touch the back arrow.

To set up email alerts:

1.
2.
3.

A

7.

To set up alerts to send to an email address, touch Device > Supplies > Email Alerts.
To enter an email address, touch Add Email, then touch Enter Email Address.

Use the touch screen keyboard to enter an email address, or select an entry from the Address Book,
then touch OK.

Add more email addresses if necessary.

To customize the alerts for each supply item, to enable or disable an alert, touch the toggle button.
To exit the menu, touch OK.

To return to the Device screen, touch the back arrow.

To check the supplies status and set up alerts using the Embedded Web Server, refer to the System
Administrator Guide at www.xerox.com/office/VLC400docs.
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Billing and Usage Counters

The Billing/Usage menu displays the total number of impressions that the printer generated or printed
during its lifetime. You cannot reset the counters. A page is counted as one side of a sheet of paper.
For example, a sheet of paper that is printed on two sides counts as two impressions.

To view the Billing and Usage Counters:

1. At the printer control panel, press the Home button.

2. Touch Device > Billing/Usage.

3. To view more details, touch Usage Counters, then select an option.

—  Impression Counters: This option displays the number of impressions made by the printer.
The number of impressions may not equal the number of sheets counted, depending on the
printer setup. The number of impressions may differ if your printer is set up to count large
sheets as large impressions or as multiple smaller impressions.

—  Sheet Counters: This option displays the number of impressions made by the printer.
Impressions for 2-Sided sheets are identified as a separate line from1-Sided sheets.

—  All Usage Counters: This option shows all the printer usage.
4.  After viewing the usage readings, to return to the Home screen, press the Home button.

Reset to Factory Defaults

The non-volatile memory (NVRAM) stores printer settings, even after the power is turned off. The Reset
to Factory Defaults feature erases all settings and returns the printer to original factory state. All jobs,
presets, Apps, and device settings are reset. When complete, the printer restarts, then displays the
Install Wizard.

To reset the printer to factory defaults:

1. At the printer control panel, press the Home button.

2. Touch Device > Resets > Reset to Factory Defaults.

3. Atthe prompt, touch Reset.

4.  When the process is complete, the printer restarts automatically.

Remote Services

You can use the Remote Services option in the Embedded Web Server to send error and usage
information to the Xerox support team to help them resolve problems quickly.

For information about enabling Remote Services and uploading information to Xerox, refer to the
System Administrator Guide at www.xerox.com/office/VLC400docs.
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Jobs

This section includes:
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e Managing Jobs using the Embedded Web SErver....... s sssssssesesssessens 67

Jobs Overview

Use Jobs to view current jobs, print saved, personal, and secure jobs, and view details
of completed jobs. You can pause, delete, print, or view job progress or job details for
a selected job.

Managing Jobs

From the control panel Jobs menu, you can view lists of active jobs, secure jobs, or completed jobs.

You can pause, delete, print, or view job progress or job details for a selected job. From the Jobs window
in the Embedded Web Server, you can view a list of active and completed print jobs. For more details,
refer to Managing Jobs using the Embedded Web Server on page 67.

A print job can be held by the printer when it is unable to complete a print job. For example, it needs
attention, paper, or supplies. When the condition is resolved, the printer automatically resumes printing.
When you send a secure print job, the job is held until you release it by typing a passcode at the control
panel. For more details, refer to Managing Special Job Types on page 63.

To pause the print job with the option to delete it:

1. At the printer control panel, press the Home button.

2. Touch Jobs, then touch the name of the desired print job.

3. Do one of the following:
—  To pause the print job, touch Pause. To resume the print job, touch Resume.
—  Todelete the print job, touch Delete. At the prompt, touch Delete.

Note: If you do not make a selection within 60 seconds, the job automatically resumes.

4. To return to the Home screen, press the Home button.
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To view, print, or delete saved and secure jobs:

1.
2.
3.

At the printer control panel, press the Home button.
To view a list of active and completed jobs, touch Jobs.
To view a list of specific job types, touch an option.

— Toview Saved Jobs, touch Saved Jobs. To print the job, touch the job, enter the quantity, then
touch OK. To delete the job, touch the Trash icon, then touch Delete.

—  To view Personal jobs, touch Personal & Secure Jobs. To print the jobs, touch the folder, then
touch Print All, or Delete All.

—  For Secure Jobs, touch Personal & Secure Jobs. Touch the folder, enter the passcode number,
then touch OK. To print a Secure Job, touch the job. To print or delete all the jobs in the folder,
touch Print All, or Delete All.

To view details about a job, touch the job.

To return to the Home screen, press the Home button.

Notes:

e  The system administrator can restrict users from deleting jobs. If a system administrator has
restricted job deletion, you can view the jobs, but not delete them.

e  Only the user that sent the job or the system administrator can delete a Secure Print job.

To print a job held for resources:

1. At the printer control panel, press the Home button.

2. Touch Jobs.

3. From the jobs list, touch the held job name. The resources required for the job appear on the
control panel.

4. Do one of the following:
— To print the job, replenish the resources required. The job resumes automatically when the

required resources are available. If the job does not print automatically, touch Resume.

—  Todelete the print job, touch Delete. At the prompt, touch Delete.

5. Toreturn to the Home screen, press the Home button.

Managing Special Job Types

Special job types allow you to send a print job from your computer, then print it from the printer
control panel. Select special job types in the print driver, Printing Options tab, under Job Type.

Saved Job

Saved Jobs are documents sent to the printer and, unless deleted, are stored there for future use.
Any user can print or delete a Saved Job.
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To print a Saved Job:

1.

In your software application, access the print settings. For most software applications, press CTRL+P
for Windows or CMD+P for Macintosh.

Select your printer, then open the print driver.

—  For Windows, click Printer Properties. Depending on your application, the title of the button
can vary.

—  For Macintosh, in the Print window, click Preview, then select Xerox Features.
For Job Type, select Saved Job.

Type a job name or select a name from the list, then click OK.

Select any other required printing options.

—  For Windows, click OK, then click Print.

—  For Macintosh, click Print.

To release a Saved Job:

1.
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At the printer control panel, press the Home button.

Touch Jobs.

To view Saved Jobs, touch Saved Jobs.

To print a Saved Job, touch the job name, enter the quantity, then touch OK.

To delete the document after printing, for that job, touch the Trash icon, then at the prompt, touch
Delete.

To return to the Home screen, press the Home button.

Secure Print

Use Secure Print to print sensitive or confidential information. After you send the job, it is held at the
printer until you enter your passcode at the printer control panel.

To print using Secure Print:

1.
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In your software application, access the print settings. For most software applications, press CTRL+P
for Windows or CMD+P for Macintosh.

Select your printer, then open the print driver.

—  For Windows, click Printer Properties. Depending on your application, the title of the button
varies.

—  For Macintosh, in the Print window, click Preview, then select Xerox Features.
For Job Type, select Secure Print.

Type the passcode, confirm the passcode, then click OK.

Select any other required printing options.

—  For Windows, click OK, then click Print.

—  For Macintosh, click Print.
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To release a Secure Print job:

At the printer control panel, press the Home button.
Touch Jobs.

To view Secure Print jobs, touch Personal & Secure Jobs.
Touch your folder.

Enter the passcode number, then touch OK.

ok wh~

Select an option:

—  To print a Secure Print job, touch the job.

— Toprint all the jobs in the folder, touch Print All.

—  Todelete a Secure Print job, touch the Trash icon, then at the prompt, touch Delete.
— To delete all the jobs in the folder, touch Delete All.

Note: After a Secure Print job is printed, it is deleted automatically.

7. Toreturn to the Home screen, press the Home button.

Personal Print

Personal Print allows you to store a document in the printer, then print it from the control panel.

Note: This feature is only available on a Windows computer printing to a network printer.

Personal Print is a type of saved job with these features:

e  APersonal Print job appears in a folder named after the user ID associated with the print job.
e APersonal Print job does not use a passcode.

e  Any user can print or delete a Personal Print job.

e You can print all jobs in the list at once, delete an individual job, or delete all jobs in the list.

e  After aPersonal Print job is printed, it is deleted automatically.

To print using Personal Print:

1. Inyour software application, access the print settings. For most software applications, click File >
Print or for Windows, press CTRL+P.

2. Select your printer, then click Printer Properties. Depending on your application, the title of the
button varies.

3. ForJob Type, select Personal Print.
4. Select any other required printing options, then click OK.
5. Tosend the job to the printer, click Print.
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To release a Personal Print job:

1.
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At the printer control panel, press the Home button.
Touch Jobs.

To view Personal Print jobs, touch Personal & Secure Jobs.
Touch your folder.

If prompted for a passcode, touch Skip.

Note: When your folder contains Secure Print jobs and Personal Print jobs, the passcode
prompt appears.

Select an option.

—  To print a Personal Print job, touch the job.

— Toprint all the jobs in the folder, touch Print All.

— Todelete all the jobs in the folder, touch Delete All.
To return to the Home screen, press the Home button.

Sample Set

The Sample Set job type prints one copy of a multiple-copy print job before printing the remaining
copies. After reviewing the sample set, you can either print the remaining copies or delete them at the
printer control panel.

Sample Set is a type of saved job with these features:

A Sample Set job appears in a folder named after the user ID associated with the print job.
A Sample Set job does not use a passcode.
Any user can print or delete a Sample Set job.

A Sample Set prints one copy of a job to allow you to proofread the job before printing any
remaining copies.

After a Sample Set job is printed, it is deleted automatically.

To print using Sample Set:

1.
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In your software application, access the print settings. For most software applications, press CTRL+P
for Windows or CMD+P for Macintosh.

Select your printer, then open the print driver.

—  For Windows, click Printer Properties. Depending on your application, the title of the
button varies.

—  For Macintosh, in the Print window, click Preview, then select Xerox Features.
For Job Type, select Sample Set.

Select any other required printing options.

—  For Windows, click OK, then click Print.

—  For Macintosh, click Print.
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To release a Sample Set:
1. At the printer control panel, press the Home button.
2. To view available jobs, touch Jobs.
3. Touch the Sample Set job.
Note: The Sample Set file description shows the job as Held for Future Printing, and shows the
number of remaining copies of the job.
4, Select an option.
—  To print the remaining copies of the job, touch Release.
—  To delete the remaining copies of the job, touch Delete.
5. Toreturn to the Home screen, press the Home button.

Managing Jobs using the Embedded Web Server

You can view a list of active jobs and delete print jobs from the Active Jobs list in the Embedded Web
Server. You can use the Embedded Web Server to submit jobs for printing at the device. You can print
.pdf, .ps, .pcl, .prn, .xps, .jpg, .tif and .txt files directly from the Embedded Web Server without opening
another application or the print driver. The files can be stored on a local computer hard drive, mass
storage device, or network drive.

To manage jobs using the Embedded Web Server:

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then
press Enter or Return.

2. Inthe Embedded Web Server, click Jobs.

3. Click the job name.

4. Do one of the following:
— To pause the print job, click Pause. To resume the print job, click Resume.
— Todelete the print job, click Delete. At the prompt, click Delete.

5. Toreturn to the Home screen, click Home.

To submit jobs for printing using the Embedded Web Server:

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then
press Enter or Return.

In the Embedded Web Server, click Home.

In the Quick Links areaq, click Submit File.

Click the Submit field.

In the selection window, select a file to print, then click Open.

ot wN

To print the document, click Submit.
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Print From USB

This section includes:
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Print From USB Overview

Use the Print From USB feature to print jobs already stored on a USB stick. Jobs in a
print-ready format, for example PDF, TIFF or JPEG can be printed.

To create a print-ready file, select the Print to File option when you print your documents from programs
such as Microsoft Word. From advanced publishing programs there may be several methods to create
print-ready files.

Printing From a USB Flash Drive

You can print a file stored on a USB Flash drive. The USB port is on the front of the printer.

Notes:

e If the device is in Power Saver mode, before proceeding with the Print job, to wake the device,
press the Power Saver button.

e  Only USB Flash drives formatted to the typical FAT32 file system are supported.

To print from a USB Flash drive:

1. Insert the USB Flash drive into the USB memory port on the printer.

2. At the USB Drive has been detected screen, touch Print from USB.
Note: If this feature does not appear, enable the feature or contact the system administrator.
For details, refer to the System Administrator Guide at www.xerox.com/office/VLC400docs.

3. Add files to the Document Source Table.

— To print a group of print-ready files, for the USB drive or folder, touch the Select All icon.
Verify that your files are selected.

— To print a specific file, browse to that file, then touch the file name or icon.
4, Touch OK.
5. Confirm that the required files are listed.
—  Toselect more files, touch Add Document, then touch OK.
—  Toremove a file name from the list, touch the file name, then touch Remove.
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Select the paper supply, quantity, output color, and 2-sided printing options.
Touch Print.
When you are finished, remove the USB Flash drive.

To print from a USB Flash drive that is already inserted in the printer:

1.
2.

If the USB Flash drive is already in the USB memory port, press the Home button.

Touch Print from USB.

Note: If this feature does not appear, enable the feature or contact the system administrator.
For details, refer to the System Administrator Guide at www.xerox.com/office/VLC400docs.
Add files to the Document Source Table.

—  To print a group of print-ready files, for the USB drive or folder, touch the Select All icon.
Verify that your files are selected.

—  To print a specific file, browse to that file, then touch the file name or icon.
Touch OK.

Confirm that the desired documents appear. If not, touch Add Document, select the additional
documents, then touch OK.

Select the paper supply, quantity, output color, and 2-sided printing options.
Touch Print.
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Printing Overview

Before printing, your computer and the printer must be plugged in, turned on, and connected. Ensure
that you have the correct print driver software installed on your computer. For details, refer to Installing
the Software on page 41.

1.
2.
3.
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Select the appropriate paper.
Load paper in the appropriate tray. On the printer control panel, specify the size, color, and type.

Access the print settings in your software application. For most software applications, press CTRL+P
for Windows, or CMD+P for Macintosh.

Select your printer.

Access the print driver settings by selecting Properties or Preferences for Windows, or Xerox®
Features for Macintosh. The title of the button can vary depending on your application.

Modify the print driver settings as necessary, then click OK.
Click Print to send the job to the printer.
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Selecting Printing Options

This section includes:
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Printing options, also called print driver software options, are specified as Printing Preferences in
Windows, and Xerox® Features in Macintosh. Printing options include settings for 2-sided printing, page
layout, and print quality. Printing options that are set from Printing Preferences become the default
setting. Printing options that are set from within the software application are temporary. The application
and the computer do not save the settings after the application is closed.

Print Driver Help

Xerox® print driver software Help information is available from the Printing Preferences window.
Click the Help (?) button in the bottom left corner of the Printing Preferences window to see the Help.

o ==
xerox g,
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Information about Printing Preferences appears in the Help window. From there, you can select by topic
or use the search field to enter the topic or function for which you need information.
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Windows Printing Options

Selecting Printing Options for an Individual Job for Windows

To use special printing options for a particular job, you can change the Printing Preferences before
sending the job to the printer.

1. With the document open in your software application, access the print settings. For most software
applications, click File > Print or press CTRL+P for Windows.

2. Select your printer and click the Properties or Preferences button to open the Printing Preferences
window. The title of the button can vary depending on your application.

3. Click atab in the Printing Preferences window, then make selections.
4. Click OK to save and close the Printing Preferences window.
5. Click Print to send the job to the printer.

Setting Default Printing Options for Windows

When you print from any software application, the printer uses the print job settings specified in the
Printing Preferences window. You can specify your most common printing options and save them so that
you do not have to change them every time you print.

For example, if you want to print on both sides of the paper for most jobs, specify 2-sided printing in
Printing Preferences.

1. Navigate to the list of printers on your computer:
—  For Windows Server 2008 and later, click Start > Settings > Printers.
—  For Windows 7, click Start > Devices and Printers.
—  For Windows 8, click Start > Control Panel > Devices and Printers.
—  For Windows 10, click the Windows Start icon > Settings > Devices > Printers & Scanners.
Scroll down in the window, then under Related settings, click Devices and printers.

Note: If you are using a custom Start Menu application, it can change the navigation path to your
list of printers.

2. Inthe list of printers, right-click the icon for your printer, then click Printing preferences.

3. Inthe Printing Preferences window, click a tab, then select the options. To save the settings,
click OK.

Note: For more information about Windows print driver options, click the Help button (?) in the
Printing Preferences window.
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Selecting Printing Defaults in Windows for a Shared Network Printer

1.
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Navigate to the list of printers on your computer:

—  For Windows Server 2008 and later, click Start > Settings > Printers.

—  For Windows 7, click Start > Devices and Printers.

—  For Windows 8, click Start > Control Panel > Devices and Printers.

—  For Windows 10, click the Windows Start icon > Settings > Devices > Printers & Scanners.
Scroll down in the window, then under Related settings, click Devices and printers.

Note: If the Control Panel icon does not appear on the desktop, right-click the desktop, then select
Personalize > Control Panel Home > Devices and Printers.

In the list of printers, right-click the icon for your printer, then select Printer properties.

In the printer Properties dialog box, click the Advanced tab.

On the Advanced tab, click Printing Defaults.

Make your selections on the print driver tabs as needed, then click Apply.

To save the settings, click OK.

Saving a Set of Commonly Used Printing Options for Windows

You can define and save a set of options, so that you can apply them to future print jobs.

To save a set of printing options:

1.
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With the document open in your application, click File > Print.

To open the Printing Preferences window, select your printer, then click Properties or Preferences.
In the Printing Properties window, click the tabs, then select the desired settings

In the Printing Properties window, click Saved Settings, then click Save As.

To save the set of options in the Saved Settings list, type a name for the set of printing options,
then click OK.
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Macintosh Printing Options

Selecting Printing Options for Macintosh

To use specific printing options, change the settings before sending the job to the printer.
1. With the document open in your application, click File > Print.
2. Select your printer.
3. Inthe Print window, click Preview, then select Xerox Features.
Note: To see all printing options, click Show Details.

4., Select any other required printing options from the lists.
5. Click Print to send the job to the printer.

Saving a Set of Commonly Used Printing Options for Macintosh
You can define and save a set of options, so that you can apply them to future print jobs.

To save a set of printing options:

1. With the document open in your application, click File > Print.

2. Select your printer from the Printers list.

3. Select the required printing options from the lists in the Print dialog box.

Note: To see all printing options, click Show Details.

4. Click Presets > Save Current Settings as Preset.
5. Type aname for the printing options. To save the set of options in the Presets list, click OK.
6. To print using these options, select the name from the Presets list.

UNIX and Linux Printing

The Xerox® Print Driver package provides tools for you to manage printers connected in UNIX and
Linux environments.

The Xerox® print drivers provide a GUI-based driver dialog for printer feature selections. You can select
print drivers based on your operating system.
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Xerox® Printer Manager

Xerox® Printer Manager is an application that allows you to manage and print to multiple printers in
UNIX and Linux environments.

Xerox® Printer Manager allows you to:

Configure and check the status of network connected printers.
Set up a printer on your network as well as monitor the operation of the printer once installed.
Perform maintenance checks and view supplies status at any time.

Provide a common look and feel across the many different suppliers of UNIX and Linux
operating systems.

Installing the Xerox® Printer Manager

Before you begin:

Ensure that you have root or superuser privileges to install Xerox® Printer Manager.

To install the Xerox® Printer Manager:

1.
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Download the appropriate package for your operating system. To locate print drivers for your
printer, go to www.xerox.com/office/drivers.

On the print driver website, navigate to your printer model.

For your printer model, click Drivers & Downloads.

From the Operating System menu, select your operating system.

To identify the print driver for your printer model, review the list of available print drivers.

Note: For additional information on each driver, click Description.

To select the print driver for your printer model and operating system, click its name.

To begin the download, read the End User License Agreement, then click accept.

The file automatically downloads to the default location for your computer file downloads.
To install the Xerox® Print Driver package:

a. Open the package with your OS package manager.

b. To install using a command-line utility, change to the directory where you downloaded the file.
To run the installer, type the appropriate command-line utility for your operating system.
For example:

e Red Hat: rpm -U <filename>.rpm
e Debian-based Linux: dpkg -i <filename>.deb
o AIX:rpm -U <filename>.rpm
e  HPUX: <filename>.depot.gz
e Solaris: pkgadd -d <filename>.pkg
Note: Most installations create a Xerox directory in /opt/Xerox/prtsys. For additional information

about utilities included in the OS package manager, refer to the manual included with the package.
For example, man xeroxprtmagr.
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Launching Xerox® Printer Manager

To launch Xerox® Printer Manager, do one of the following tasks.
e  For UNIX, log in as root. From a terminal window, type xosdprtmgr, then press Enter or Return.
e  For Linux, type sudo xeroxprtmgr, then press Enter or Return.

Printing with xeroxprint
Xerox has its own print command. You can use the following command:

xeroxprint -d<Some_Queue> -o[Options] <Somefile>

Printing from a Linux Workstation

To print from a Linux workstation, install either a Xerox® print driver for Linux or a CUPS print driver.
You do not need both drivers.

Xerox recommends that you install one of the full-featured custom print drivers for Linux. To locate
drivers for your printer, go to www.xerox.com/office/drivers.

If you use CUPS, ensure that CUPS is installed and running on your workstation. The instructions for
installing and building CUPS are contained in the CUPS Software Administrators Manual, written and
copyrighted by Easy Software Products. For complete information on CUPS printing capabilities, refer
to the CUPS Software Users Manual available from www.cups.org/documentation.php.

Installing the PPD on the Workstation

1. If available, download the Xerox® PPD for CUPS from the Drivers and Downloads page on the
Xerox Support website.

2. Copy the PPD into the CUPS ppd/Xerox folder on your workstation. If you are unsure of the location
of the folder, use the Find command to locate the PPD files.

3. Follow the instructions that are included with the PPD.

Adding the Printer

1. Verify that the CUPS daemon is running.

2. Open aWeb browser and type http://localhost:631/admin, then click Enter or Return.

3. For User ID, type root. For password, type the root password.

4. Click Add Printer and follow the onscreen prompts to add the printer to the CUPS printer list.

Printing with CUPS

CUPS supports the use of both the System V (lp) and Berkeley (lpr) printing commands.
1. To print to a specific printer in System V, type: lp -dprinter filename, then click Enter.
2. To print to a specific printer in Berkeley, type: lpr -Pprinter filename, then click Enter.
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Mobile Printing Options

This printer can print from iOS and Android mobile devices.

Printing with Wi-Fi Direct

You can connect to your printer from a Wi-Fi mobile device, such as a tablet, computer, or smart phone,
using Wi-Fi Direct.

For details, refer to Connecting with Wi-Fi Direct on page 38.

For details on using Wi-Fi Direct, refer to the documentation provided with your mobile device.

Note: Depending on which mobile device you are using, the printing procedure varies.

Printing with AirPrint

You can print directly from your iPhone, iPad, iPod touch, or Mac using AirPrint. To enable AirPrint for
your printer, refer to Configuring AirPrint. To use AirPrint, ensure that your mobile device is connected
to the same wireless network as the printer.

To print with AirPrint:

1. Open the email, photograph, website page, or document that you want to print.
Tap the Action icon.

Tap Print.

Select your printer, then set the printer options.

Tap Print.
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Printing from a Mopria-Enabled Mobile Device

Mopria is a software feature that enables users to print from mobile devices without requiring a print
driver. You can use Mopria to print from your mobile device to Mopria-enabled printers.

Notes:

e  Mopria and all of its required protocols are enabled by default.

e  Ensure that you have the latest version of the Mopria Print Service installed on your mobile
device. You can obtain a free download from the Google Play Store.

e  Wireless devices must join the same wireless network as the printer.

e The name and location of your printer appears in a list of Mopria-enabled printers on
connected devices.

To print using Mopria, follow the directions provided with your mobile device.
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Printing From a USB Flash Drive

You can print a file stored on a USB Flash drive. The USB port is on the front of the printer.
Notes:

e If the device is in Power Saver mode, before proceeding with the Print job, to wake the device,
press the Power Saver button.

e  Only USB Flash drives formatted to the typical FAT32 file system are supported.

To print from a USB Flash drive:

1.
2.

6.
7.
8.

Insert the USB Flash drive into the USB memory port on the printer.

At the USB Drive has been detected screen, touch Print from USB.

Note: If this feature does not appear, enable the feature or contact the system administrator.
For details, refer to the System Administrator Guide at www.xerox.com/office/VLC400docs.
Add files to the Document Source Table.

—  To print a group of print-ready files, for the USB drive or folder, touch the Select All icon.
Verify that your files are selected.

—  To print a specific file, browse to that file, then touch the file name or icon.
Touch OK.

Confirm that the required files are listed.

—  Toselect more files, touch Add Document, then touch OK.

— Toremove a file name from the list, touch the file name, then touch Remove.
Select the paper supply, quantity, output color, and 2-sided printing options.
Touch Print.

When you are finished, remove the USB Flash drive.

To print from a USB Flash drive that is already inserted in the printer:

1.
2.
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If the USB Flash drive is already in the USB memory port, press the Home button.

Touch Print from USB.

Note: If this feature does not appear, enable the feature or contact the system administrator.
For details, refer to the Systerm Administrator Guide at www.xerox.com/office/VLC400docs.
Add files to the Document Source Table.

—  To print a group of print-ready files, for the USB drive or folder, touch the Select All icon.
Verify that your files are selected.

—  To print a specific file, browse to that file, then touch the file name or icon.
Touch OK.

Confirm that the desired documents appear. If not, touch Add Document, select the additional
documents, then touch OK.

Select the paper supply, quantity, output color, and 2-sided printing options.
Touch Print.
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Managing Jobs

From the Jobs window in the Embedded Web Server, you can view a list of active and completed
print jobs.

From the control panel Jobs menu, you can view lists of active jobs, secure jobs, or completed jobs.

You can pause, delete, print, or view job progress or job details for a selected job. When you send a
secure print job, the job is held until you release it by typing a passcode at the control panel. For details,
refer to Printing Special Job Types on page 82.

To pause the print job with the option to delete it:

1. At the printer control panel, press the Home button.

2. Touch Jobs, then touch the name of the desired print job.
3. Do one of the following:

—  To pause the print job, touch Pause. To resume the print job, touch Resume.
— Todelete the print job, touch Delete. At the prompt, touch Delete.

Note: If you do not make a selection within 60 seconds, the job automatically resumes.

4. Toreturn to the Home screen, press the Home button.
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To view, print, or delete jobs:

1. At the printer control panel, press the Home button.

2. Toview a list of active and completed jobs, touch Jobs.
3. Toview a list of specific job types, touch an option.

— Toview Saved Jobs, touch Saved Jobs. To print the job, touch the job, enter the quantity, then
touch OK. To delete the job, touch the Trash icon, then touch Delete.

—  Toview Personal jobs, touch Personal & Secure Jobs. To print the jobs, touch the folder, then
touch Print All, or Delete All.

—  For Secure Jobs, touch Personal & Secure Jobs. Touch the folder, enter the passcode number,
then touch OK. To print a Secure Job, touch the job. To print or delete all the jobs in the folder,
touch Print All, or Delete All.

4. To view details about a job, touch the job.
5. Toreturn to the Home screen, press the Home button.
Notes:
e  The system administrator can restrict users from deleting jobs. If a system administrator has
restricted job deletion, you can view the jobs, but not delete them.
e  Only the user that sent the job or the system administrator can delete a Secure Print job.

Printing Special Job Types

Special job types allow you to send a print job from your computer, then print it from the printer control
panel. Select special job types in the print driver, Printing Options tab, under Job Type.

Saved Job

Saved Jobs are documents sent to the printer and, unless deleted, are stored there for future use. Any
user can print or delete a Saved Job.

To print a Saved Job:

1. Inyour software application, access the print settings. For most software applications, press CTRL+P
for Windows or CMD+P for Macintosh.

2. Select your printer, then open the print driver.

—  For Windows, click Printer Properties. Depending on your application, the title of the button
can vary.

—  For Macintosh, in the Print window, click Preview, then select Xerox Features.
3. ForJob Type, select Saved Job.
4. Type ajob name or select a name from the list, then click OK.
5. Select any other required printing options.

—  For Windows, click OK, then click Print.

—  For Macintosh, click Print.
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To release a Saved Job:

1. At the printer control panel, press the Home button.

Touch Jobs.

To view Saved Jobs, touch Saved Jobs.

To print a Saved Job, touch the job name, enter the quantity, then touch OK.

To delete the document after printing, for that job, touch the Trash icon, then at the prompt,
touch Delete.

- whN

6. Toreturn to the Home screen, press the Home button.

Secure Print

Use Secure Print to print sensitive or confidential information. After you send the job, it is held at the
printer until you enter your passcode at the printer control panel.

To print using Secure Print:

1. Inyour software application, access the print settings. For most software applications, press CTRL+P
for Windows or CMD+P for Macintosh.

2. Select your printer, then open the print driver.

—  For Windows, click Printer Properties. Depending on your application, the title of the
button varies.

—  For Macintosh, in the Print window, click Preview, then select Xerox Features.
3. ForJob Type, select Secure Print.
4. Type the passcode, confirm the passcode, then click OK.
5.  Select any other required printing options.

—  For Windows, click OK, then click Print.

—  For Macintosh, click Print.

To release a Secure Print job:

At the printer control panel, press the Home button.
Touch Jobs.

To view Secure Print jobs, touch Personal & Secure Jobs.
Touch your folder.

Enter the passcode number, then touch OK.

Select an option:

ot whN-=

—  To print a Secure Print job, touch the job.

— Toprint all the jobs in the folder, touch Print All.

— Todelete a Secure Print job, touch the Trash icon, then at the prompt, touch Delete.
— Todelete all the jobs in the folder, touch Delete All.

Note: After a Secure Print job is printed, it is deleted automatically.

7. Toreturn to the Home screen, press the Home button.
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Personal Print

Personal Print allows you to store a document in the printer, then print it from the control panel.

Note: This feature is only available on a Windows computer printing to a network printer.

Personal Print is a type of saved job with these features:

A Personal Print job appears in a folder named after the user ID associated with the print job.
A Personal Print job does not use a passcode.

Any user can print or delete a Personal Print job.

You can print all jobs in the list at once, delete an individual job, or delete all jobs in the list.
After a Personal Print job is printed, it is deleted automatically.

To print using Personal Print:

1.

In your software application, access the print settings. For most software applications, click File >
Print or for Windows, press CTRL+P.

Select your printer, then click Printer Properties. Depending on your application, the title of the
button varies.

For Job Type, select Personal Print.
Select any other required printing options, then click OK.
To send the job to the printer, click Print.

To release a Personal Print job:

1.

v &~ W
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At the printer control panel, press the Home button.
Touch Jobs.

To view Personal Print jobs, touch Personal & Secure Jobs.
Touch your folder.

If prompted for a passcode, touch Skip.

Note: When your folder contains Secure Print jobs and Personal Print jobs, the passcode prompt
appears.

Select an option.

—  To print a Personal Print job, touch the job.

— Toprint all the jobs in the folder, touch Print All.

— Todelete all the jobs in the folder, touch Delete All.
To return to the Home screen, press the Home button.
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Sample Set

The Sample Set job type prints one copy of a multiple-copy print job before printing the remaining
copies. After reviewing the sample set, you can either print the remaining copies or delete them at the
printer control panel.

Sample Set is a type of saved job with these features:

e A Sample Set job appears in a folder named after the user ID associated with the print job.

e A Sample Set job does not use a passcode.

e Any user can print or delete a Sample Set job.

e A Sample Set prints one copy of a job to allow you to proofread the job before printing any
remaining copies.

After a Sample Set job is printed, it is deleted automatically.

To print using Sample Set:

1. Inyour software application, access the print settings. For most software applications, press CTRL+P
for Windows or CMD+P for Macintosh.

2. Select your printer, then open the print driver.

—  For Windows, click Printer Properties. Depending on your application, the title of the
button varies.

—  For Macintosh, in the Print window, click Preview, then select Xerox Features.
3. ForJob Type, select Sample Set.
4, Select any other required printing options.

—  For Windows, click OK, then click Print.

—  For Macintosh, click Print.

To release a Sample Set:
1. At the printer control panel, press the Home button.
2. Toview available jobs, touch Jobs.
3. Touch the Sample Set job.
Note: The Sample Set file description shows the job as Held for Future Printing, and shows the
number of remaining copies of the job.
4, Select an option.
—  To print the remaining copies of the job, touch Release.
— To delete the remaining copies of the job, touch Delete.
5. Toreturn to the Home screen, press the Home button.
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Selecting Paper Options for Printing

There are two ways to select the paper for your print job. You can let the printer select which paper to
use based on the document size, paper type, and paper color you specify. You can also select a specific
tray loaded with the desired paper.

e For Windows, paper options are in the Paper field on the Printing Options tab.

e  For Macintosh, in the Print window, in Xerox Features, paper options are in the Paper field for
Paper/Output.

Scaling

Scaling reduces or enlarges the original document to match the selected output paper size.
e  For Windows, the scale options are on the Printing Options tab, in the Paper field.

e  For Macintosh, the scale options are in the Print window for Preview. To view more printing options,
click Show Details.

The following scaling options are available:

e Automatically Scale scales the document to fit the selected Output Paper Size. The scaling amount
appears in the percentage box below the sample image.

e No Scaling does not change the size of the page image printed on the output paper, and 100 %
appears in the percentage box. If the original size is larger than the output size, the page image is
cropped. If the original size is smaller than the output size, extra space appears around the page
image.

e  Manually Scale scales the document by the amount entered in the percentage box below the
preview image.
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Printing on Both Sides of the Paper

Printing a 2-Sided Document

If your printer supports Automatic 2-Sided Printing, the options are specified in the print driver.
The print driver uses the settings for portrait or landscape orientation from the application for printing
the document.

Note: Ensure that the paper size and weight are supported. For details, refer to Supported Paper Sizes
and Weights for Automatic 2-Sided Printing.

2-Sided Page Layout Options

You can specify the page layout for 2-sided printing, which determines how the printed pages turn.
These settings override the application page orientation settings.

e 1-Sided Print: This option prints on one side of the media. Use this option when printing on
envelopes, labels, or other media that cannot be printed on both sides.

e  2-Sided Print: This option prints the job on both sides of the paper to allow binding on the long
edge of the paper. The following illustrations show the result for documents with portrait and
landscape orientations, respectively:

T B

e  2-Sided Print, Flip on Short Edge: Prints on both sides of the paper. The images print to allow
binding on the short edge of the paper. The following illustrations show the result for documents
with portrait and landscape orientations, respectively:

) T

Note: 2-Sided Printing is part of the Earth Smart settings.

To change your default print driver settings, refer to Setting Default Printing Options for Windows on
page 74.

Print Quality

Print-quality modes:
e Standard print-quality mode: 600 x 600 dpi
e  Enhanced print-quality mode: 600 x 600 dpi, 8-bit depth
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Image Options

Image options controls the how the printer uses color to produce your document. The Windows
PostScript print driver and the Macintosh print drivers provide the widest range of color controls and
corrections on the Image Options tab.

e  For Windows, Color Corrections and Color Adjustment are on the Image Options tab.
e  For Macintosh, in the Print window, in Xerox Features, Color Options is on the Paper/Output list.

The following options are available:

e Xerox Black and White: This feature converts all color in the document to black and white or
shades of gray.

e Xerox Automatic Color: This option applies the best color correction to text, graphics, and images.
Xerox recommends this setting.

e Vivid RGB: This setting produces brighter and more saturated colors using red, green, and blue color.
e  Commercial: This option applies color for printing on a commercial printing press.

Image Shift

Image Shift allows you to modify the location of the image on the page. You can shift the printed image
along the X and Y axes of each sheet of paper.

Color Adjustments

Use Color Adjustments to adjust particular characteristics of the printed color. Characteristics include
lightness, contrast, saturation, and color cast.

Note: Not all options listed are supported on all printers. Some options apply only to a specific printer
model, configuration, operating system, or driver type.

Lightness

The Lightness feature allows you to adjust the overall lightness or darkness of the text and images in
your printed job.

Contrast

You can use the Contrast feature to adjust the variation between light and dark areas of the print job.

Saturation

Saturation allows you to adjust the color strength and the amount of gray in the color.
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Color Cast

Use Color Cast settings to adjust the amount of a selected color in the print job while
preserving lightness.

The following options are available:

e The Cyan to Red option allows you to adjust the color balance between cyan and red. For example,
when you increase the cyan levels, the red levels decrease.

e The Magenta to Green option allows you to adjust the color balance between magenta and green.
For example, when you increase the magenta levels, the green levels decrease.

e The Yellow to Blue option allows you to adjust the color balance between yellow and blue. For
example, when you increase the yellow levels, the blue levels decrease.

Printing Mirror Images

If the PostScript driver is installed, you can print pages as a mirror image. Images mirror left to right
when printed.

Printing Multiple Pages to a Single Sheet
When printing a multiple-page document, you can print more than one page on a single sheet of paper.

Toprint 1, 2,4, 6,9, or 16 pages per side, select Pages Per Sheet on the Page Layout tab.
e  For Windows, Page Layout is on the Document Options tab.
e  For Macintosh, in the Print window, Layout is on the Preview list.

Printing Booklets

With 2-sided printing, you can print a document in the form of a small booklet. You can create booklets
from any paper size that is supported for 2-sided printing.

The print driver automatically reduces each page image and prints four page images per sheet of paper,
two page images on each side. The pages are printed in the correct order so that you can fold and staple
the pages to create the booklet.

e  For Windows, Booklet Layout is on the Page Layout tab. Page Layout is on the Document
Options tab.

e  For Macintosh, in the Print window, in Xerox Features, Booklet Layout is on the Paper/Output list.
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When you print booklets using the Windows PostScript or Macintosh driver, you can specify the gutter
and creep.

e  Gutter: Specifies the horizontal distance in points between the page images. A point is
0.35mm (1/72in.).

e  Creep: Specifies how much the page images shift outward in tenths of a point. Shifting
compensates for the thickness of the folded paper, which can cause the page images to shift
outward slightly when folded. You can select a value from zero to 1 point.

P
/

Using Special Pages

The Special Pages options control how covers, inserts, and exception pages are added to your
printed document.

e  For Windows, the Special Pages tab is on the Document Options tab.

e  For Macintosh, in the Print window, in Xerox Features, Special Pages is on the Paper/Output
drop-down list.

Printing Cover Pages

A cover page is the first or last page of a document. You can select paper sources for the cover pages
that are different from the source used for the body of a document. For example, you can use your
company letterhead for the first page of a document. You can also use heavyweight paper for the first
and last pages of a report. You can use any applicable paper tray as the source for printing cover pages.

Select one of these options for printing cover pages:

e No Covers does not print cover pages. No cover pages are added to the document.

e  Front Only prints the first page on paper from the specified tray.

e  Back Only prints the back page on paper from the specified tray.

e  Front and Back: Same prints the front and back cover pages from the same tray.

e Front and Back: Different prints the front and back cover pages from different trays.

After making a selection for printing the cover pages, you can select the paper for the front and back
covers by size, color, or type. You can also use blank or pre-printed paper, and you can print side one, side
two, or both sides of the cover pages.
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Printing Insert Pages

You can add blank or pre-printed insert pages before page one of each document or after designated
pages within a document. Adding an insert after designated pages within a document separates
sections, or acts as a marker or placeholder. Ensure that you specify the paper to use for the insert pages.

e Insert Options provides the options to place an insert After Page X, where X is the specified page, or
Before Page 1.

e Insert Quantity specifies the number of pages to insert at each location.

e Pages: Specifies the page or range of pages that use the exception page characteristics.
Separate individual pages or page ranges with commas. Specify pages within a range with a
hyphen. For example, to specify pages 1, 6,9, 10, and 11, type 1, 6, 9-11.

e  Paper: Displays the default size, color, and type of paper selected in Use Job Settings.
e Job Setting: Displays the attributes of the paper for the remainder of the job.

Printing Exception Pages

Exception pages have different settings from the rest of the pages in the job. You can specify differences
such as page size, page type, and page color. You can also change the side of the paper on which to print
as your job requires. A print job can contain multiple exceptions.

For example, your print job contains 30 pages. You want five pages to print on only one side of a special
paper, and the remainder of the pages printed 2-sided on regular paper. You can use exception pages to
print the job.

In the Add Exceptions window, you can set the characteristics of the exception pages and select the
alternate paper source:

e Pages: Specifies the page or range of pages that use the exception page characteristics.
Separate individual pages or page ranges with commas. Specify pages within a range with a
hyphen. For example, to specify pages 1, 6,9, 10, and 11, type 1, 6, 9-11.

e  Paper: Displays the default size, color, and type of paper selected in Use Job Settings.

e  2-Sided Printing allows you to select 2-sided printing options. Click the Down arrow to select
an option:

— 1-Sided Print prints the exception pages on one side only.

—  2-Sided Print prints the exception pages on both sides of the paper and flips the pages on the
long edge. The job then can be bound on the long edge of the pages.

—  2-Sided Print, Flip on Short Edge prints the exception pages on both sides of the paper and
flips the pages on the short edge. The job then can be bound on the short edge of the pages.

—  Use Job Setting prints the job using the attributes shown in the Job Settings box.
e Job Setting: Displays the attributes of the paper for the remainder of the job.

Note: Some combinations of 2-sided printing with certain paper types and sizes can produce
unexpected results.
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Printing Watermarks for Windows

A watermark is special purpose text that can be printed across one or more pages. For example, you
can add a word like Copy, Draft, or Confidential as a watermark instead of stamping it on a document
before distribution.

Note: This feature is only available on a Windows computer printing to a network printer.

To print a watermark:
1. Inthe print driver, click the Document Options tab.
2. Click the Watermark tab.

3. From the Watermark menu, select the watermark. You can choose from preset watermarks, or
create a customized watermark. You can also manage watermarks from this menu.

4. Under Text, select an option:
—  Text: Enter the text in the field, then specify the font.
—  Time Stamp: Specify the date and time options, then specify the font.
—  Picture: To locate the picture, click the Browse icon.

5. Specify the scaling angle and position of the watermark.

—  Select the scaling option that specifies the size of the picture in relation to the original image.
Use the arrows to scale the image in increments of 1%.

— To define the angle of the image on the page, specify the position option or to rotate the
image left or right by increments of 1, use the arrows.

— Todefine the location of the image on the page, specify the position option, or to move the
image in each direction in increments of 1, use the arrows.

6. Under Layering, select how to print the watermark.
—  Print in Background prints the watermark behind the text and graphics in the document.

—  Blend: This option combines the watermark with the text and graphics in the document.
A blended watermark is translucent, so you can see both the watermark and the
document content.

—  Print in Foreground prints the watermark over the text and graphics in the document.
7. Click Pages, then select the pages to print the watermark:

—  Print on All Pages prints the watermark on all pages of your document.

—  Print on Page 1 Only prints the watermark only on the first page of the document.
8. If you select a picture as a watermark, specify the lightness settings for the image.
9. Click OK.
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Orientation
Orientation allows you to select the direction that the page prints.
e  For Windows, the Orientation tab is on the Document Options tab.

Note: The orientation setting in your application print dialog box may override the orientation
options in the print driver.

e  For Macintosh, Orientation options are in the Print window for Preview.

The following options are available:

e  Portrait: Orients the paper so that the text and images print across the short dimension of
the paper.

e Landscape: Orients the paper so that the text and images print across the long dimension of
the paper.

e Rotated Landscape: Orients the paper so that the content is rotated 180 degrees and with the long
bottom side up.

Note: For Macintosh, to print portrait text and images in landscape orientation, clear the Auto
Rotate check box.

Printing Banner Pages

To enable or disable Banner Pages, contact your system administrator, or refer to the System
Administrator Guide at www.xerox.com/office/VLC400docs.

Selecting Job Completion Notification for Windows

You can select to be notified when your job finishes printing. A message appears on your computer
screen with the name of the job and the name of the printer where it was printed.

Note: This feature is only available on a Windows computer printing to a network printer.

To select job completion notification from the Advanced tab:
1. Click Notifications.
2. Click Notify for Completed Jobs, then select an option.
—  Enabled: This option turns on notifications.
— Disabled: This option turns off the Notification feature.
3. Click OK.
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Using Custom Paper Sizes

This section includes:
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You can print on custom paper sizes that are within the minimum and maximum size range supported by
the printer. For details, refer to Supported Custom Paper Sizes on page 101.

Printing on Custom Paper Sizes

Note: Before printing on a custom paper size, use the Custom Paper Sizes feature in printer
properties to define the custom size. For details, refer to Defining Custom Paper Sizes on page 94.

Printing on Custom Paper Size from Windows
Note: Before printing on custom-size paper, define the custom size in the printer properties.

Load the custom-size paper in the tray.

In the application, click File > Print, then select your printer.

In the Print dialog box, click Printer Properties.

On the Printing Options tab, from the Paper list, select the required custom paper size and type.
Select any other required options, then click OK.
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In the Print dialog box, click Print.

Printing on Custom Paper Size from Macintosh

1. Load the custom-size paper. For details, refer to Loading Paper on page 102.
2. Inthe application, click File > Print.

3. From the Paper Size list, select the custom paper size.

4. Click Print.

Defining Custom Paper Sizes

To print custom paper sizes, define the custom width and length of the paper in the print driver software
and on the printer control panel. When setting the paper size, ensure that you specify the same size as
the paper in the tray. Setting the wrong size can cause a printer error. Print driver settings override
control panel settings when you print using the print driver software on your computer.
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Creating and Saving Custom Paper Sizes in the Print Driver

You can print custom-size paper from any paper tray. Custom-size paper settings are saved in the print
driver and are available for you to select in all your applications.

For detail on supported paper sizes for each tray, refer to Supported Custom Paper Sizes on page 101.

To create and save custom sizes for Windows:

1.
2.

5.

In the print driver, click the Printing Options tab.

For Paper, click the arrow, then select Other Size > Advanced Paper Size > Output Paper
Size > New.

In the New Custom Paper Size window, enter the height and width of the new size.

To specify the units of measurement, at the bottom of the window, click the Measurements button,
then select Inches or Millimeters.

To save, in the Name field, type a title for the new size, then click OK.

To create and save custom sizes for Macintosh:

o bswhN-~

In the application, click File > Print.

Click Paper Size, then select Manage Custom Sizes.

To add a new size, in the Manage Paper Sizes window, click the plus sign (+).
Double-click Untitled, then type a name for the new custom size.

Enter the height and width of the new custom size.

Click the arrow for the Non-Printable Area field, then select the printer from the list. Or, for User
Defined margins, set the top, bottom, right, and left margins.

To save the settings, click OK.

Defining a Custom Paper Size at the Control Panel

You can print custom-size paper from any paper tray. Custom-size paper settings are saved in the print
driver and are available for you to select in all your applications.

1.

No v EWN

At the printer control panel, press the Home button.

Touch Device > Paper Trays.

Touch the desired tray for your custom-size paper.

Touch the current size setting, then from the list, touch Custom.

In the Custom Paper Size screen, enter the height and width of the new size.
To save the setting, touch OK.

To return to the Home screen, press the Home button.
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This chapter includes:
e  Supported Paper

e Loading Paper

e  Printing on Special Paper
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Supported Paper

This section includes:
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®  PAPEr STOTAGE GUIAEIINES. ...ttt sass s sss s s sass b s s b ss b s b s s b s s b s s s sas st senes 99
o Supported Paper TYPES AN WEIGNTS ...ttt s ssssssssssssssssssssssssssssssssssssssssssssssenns 100
o SUPPOrted StANAArA PAPEE SIZES....... i sesssss st essssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnnes 100
e  Supported Standard Paper Sizes for Automatic 2-Sided Printing .....c..ccccecereeenrreesnsinsisssnsissesssessenssenns 100
®  SUPPOrted CUSLOM PUPET SIZES......ceiveeierrenririensississsssesssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssanss 101
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Your printer is designed to use various paper and other media types. To ensure the best print quality and
to avoid jams, follow the guidelines in this section.

For best results, use Xerox paper and media recommended for your printer.

Recommended Media

A list of paper and media recommended for your printer is available at:
e www.xerox.com/rmlna Recommended Media List (United States)
e www.xerox.com/rmleu Recommended Media List (Europe)

Ordering Paper

To order paper or other media, contact your local reseller or visit www.xerox.com/office/VLC400supplies.

General Paper Loading Guidelines

e Do not overfill the paper trays. Do not load paper above the maximum fill line in the tray.
e Adjust the paper guides to fit the paper size.

e Fan paper before loading it in the paper tray.

e If excessive jams occur, use paper or other approved media from a new package.

e Do not print on label media once a label has been removed from a sheet.

e Use only paper envelopes. Print envelopes 1-sided only.
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Paper That Can Damage Your Printer

Some paper and other media types can cause poor output quality, increased paper jams, or damage
your printer. Do not use the following:

Rough or porous paper

Inkjet paper

Non-laser glossy or coated paper
Paper that has been photocopied
Paper that has been folded or wrinkled
Paper with cutouts or perforations
Stapled paper

Envelopes with windows, metal clasps, side seams, or adhesives with release strips
Padded envelopes

Plastic media

Transparencies

CAUTION: The Xerox Warranty, Service Agreement, or Xerox Total Satisfaction Guarantee
does not cover damage caused by using unsupported paper or specialty media. The Xerox
Total Satisfaction Guarantee is available in the United States and Canada. Coverage could
vary outside these areas. Please contact your local representative for details.

Paper Storage Guidelines

Storing your paper and other media properly contributes to optimum print quality.

Store paper in dark, cool, relatively dry locations. Most paper is susceptible to damage from
ultraviolet and visible light. Ultraviolet light, from the sun and fluorescent bulbs, is particularly
damaging to paper.

Reduce the exposure of paper to strong lights for long periods of time.

Maintain constant temperatures and relative humidity.

Avoid storing paper in attics, kitchens, garages, or basements. These spaces are more likely to
collect moisture.

Store paper flat, either on pallets, cartons, shelves, or in cabinets.
Avoid food or drinks in the area where paper is stored or handled.

Do not open sealed packages of paper until you are ready to load them into the printer. Leave
stored paper in the original packaging. The paper wrapper protects the paper from moisture loss
or gain.

Some special media is packaged inside resealable plastic bags. Store the media inside the bag until
you are ready to use it. Keep unused media in the bag and reseal it for protection.
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Supported Paper Types and Weights

Trays Paper Types Weights

All Trays Recycled 60-105 g/m?
2-Sided 60-163 g/m*2
Bond 75-105 g/m?
Hole-Punched
Letterhead
Plain
Pre-Printed
Lightweight Cardstock 106-163 g/m?
Lightweight Glossy Cardstock
Cardstock 164-220g/m?
Glossy Cardstock

Bypass Tray Envelopes 60-220g/m?
Labels

Supported Standard Paper Sizes

European Standard Sizes North American Standard Sizes
All Trays A4(210x 297 mm, 8.3 x11.7in.) Legal (216 x 356 mm, 8.5 x 14 in.)

A5 (148 x 210 mm, 5.8 x 8.3 in.) Folio (216 x 330 mm, 8.5x 13 in.)

215x315mm, 8.5x 124 in. Letter (216 x 279 mm, 8.5x 11 in.)

Executive (184 x 267 mm, 7.25x 10.5in.)
203 x 254 mm, 8 x 10 in.

Bypass Tray C5 envelope (162 x 229 mm, 6.4 x 9 in.) Monarch envelope (98 x 190 mm, 3.9 x 7.5in.)
C6 envelope (114 x 162 mm, 4.5 x 6.38 in.) No. 10 envelope (241 x 105 mm, 4.1 x 9.5in.)
DL envelope (110 x 220 mm, 4.33 x 8.66 in.) |Postcard (102 x 152 mm, 4 x 6 in.)

127 x 178 mm, 5x 7 in.

Statement (140 x 216 mm, 5.5 x 8.5 in.)

Supported Standard Paper Sizes for Automatic 2-Sided Printing

European Standard Sizes North American Standard Sizes
A4 (210 x 297 mm, 8.3 x11.7in.) Legal (216 x 356 mm, 8.5 x 14 in.)
A5 (148 x 210 mm, 5.8 x 8.3 in.) Letter (216 x 279 mm, 8.5x 11 in.)
215x315mm, 8.5x 124 in. Folio (216 x 330 mm, 8.5x 13 in.)

Executive (184 x 267 mm, 7.25 x 10.5 in.)
203 x 254 mm, 8 x10in.
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Supported Custom Paper Sizes

Tray Number Paper Sizes

Tray 1 Minimum: 148 x 210 mm (5.8 x 8.3 in.)
Maximum: 216 x 356 mm (8.5 x 14in.)

Tray 2 Minimum: 148 x 210 mm (5.8 x 8.3 in.)
Maximum: 216 x 356 mm (8.5 x 14in.)

Bypass Tray Minimum: 76.2 x 127 mm (3 x 5 in.)
Maximum: 216 x 356 mm (8.5 x 14 in.)

2-Sided Printing Minimum: 148 x 210 mm (5.8 x 8.3 in.)
Maximum: 216 x 356 mm (8.5 x 14in.)

Cardstock

You can print Cardstock up to 220 g/m? from any tray. For types and weights of supported Cardstock
for 1-Sided printing, refer to Supported Paper Types and Weights. For types and weights of supported
Cardstock for 2-Sided printing, refer to Supported Paper Types and Weights for Automatic

2-Sided Printing.

Follow the guidelines for printing on glossy cardstock:

e Do not open sealed packages of glossy cardstock until you are ready to load them into the printer.

e Leave glossy cardstock in the original wrapper, and leave the packages in the shipping carton until
ready to use.

e Remove all other paper from the tray before loading glossy cardstock.

e Load only the amount of glossy cardstock you are planning to use. Do not leave glossy cardstock in
the tray when you are finished printing. Replace unused cardstock in the original wrapper and seal.

e Rotate stock frequently. Long periods of storage in extreme conditions can cause glossy cardstock to
curl and jam in the printer.

e Inthe print driver software, select the desired glossy cardstock type or select the tray loaded with
the desired paper.

Xerox® VersalLink® C400 Color Printer 101
User Guide



Paper and Media

Loading Paper

This section includes:

ChaNGiNgG POPET SEELINGS.....vvrieereieeereiressiseiresse s ssssss s s sssssssssssssssssssssssssssssssssssssasasssssssssssssssssassssasssnees 102
Loading PAPEr in TrAYS T AN 2.t sssessssssssssssssssssssssssssssssssssssssssssesssssssssssssssssssssssssssssssens 103
Loading PAper in the BYPASS TIQAY ...ccverveeeerrerierinsisesisssessissesssssssssssssssssssssssssssssssssssssssssssssssssssssssssssassssssssssssssnns 106
Configuring Trays 1 or 2 for the PAPer LENGtN ... sssssssssssssesssssssssssssssenns 109

Changing Paper Settings

When you load paper into a tray, you can change the tray settings. The following options are available:

—  Fully Adjustable: If you select this paper setting, you can change the paper size, type, and
color when you load paper into the tray.

— Dedicated: If you select this paper setting, you cannot change the paper size, type, and color
when you load paper into the tray.

—  Bypass: When paper is present in this tray, it is used for print jobs where you did not specify a
particular tray.

For details on how to change the paper setting when loading paper in trays 1 and 2, refer to Loading
Paper in Trays 1 and 2. For details on how to change the paper setting when loading paper in the bypass
tray, refer to Loading Paper in the Bypass Tray.
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Loading Paper in Trays 1 and 2

You can adjust the length of the paper tray to accommodate A4, Letter (8.5 x 11 in.), and Legal
(8.5 x 14in.) paper sizes.

To load paper in Trays 1 and 2:
1. Toremove the tray from the printer, pull out the tray until it stops, lift the front of the tray slightly,

then pull it out.

2. At the back of the paper tray, press the paper lift tray down until it locks.
3. Adjust the paper length and width guides as illustrated.

4.  Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface.
This procedure separates any sheets that are stuck together and reduces the possibility of jams.
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5.  Load paper into the tray with the print side face up.

—  Load hole-punched paper with the holes to the left.

—  For 1-sided printing, load letterhead paper face up with the top of the paper toward the back of
the tray.

—  For 2-sided printing, load letterhead and pre-printed paper face down with the top edge
feeding into the printer.

Note: Do not load paper above the maximum fill line. Overfilling the tray can cause the printer

to jam.

7. Slide the tray back into the printer.
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Notes:

If the tray does not go all the way in, ensure that the paper lift at the back of the tray is
locked down.

To avoid paper jams, do not remove the paper cover while printing is in progress.

If the tray is extended for legal-size paper, the tray protrudes when it is inserted into
the printer.

e To confirm the same paper size, type, or color, touch OK.

e Toselect a new paper size, type or color, touch the current setting, then select a new
setting. When you are finished, touch OK.

To change a paper tray to Dedicated mode:

a.

b.
C.
d

At the printer control panel, press the Home button.

Touch Device > Paper Trays.

In the Paper Trays menu, touch the preferred tray.

To dedicate the tray for a paper size, type, or color, touch Tray Mode, then touch Dedicated.
e Toselect a paper size, touch the current size setting, then select a size.

e Toselect apaper type, touch the current paper type, then select a paper type.

e Toselect apaper color, touch the current paper color, then select a paper color.

To save the settings, touch OK.

To return to the Home screen, press the Home button.
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Loading Paper in the Bypass Tray

The Bypass Tray supports the widest variety of media types. It is intended primarily for small-quantity
jobs that use special media.

To load paper in the bypass tray:
1. Open the bypass tray. If the bypass tray is loaded with paper already, remove any paper that is a
different size or type.

2. Pull out the extension tray for larger sizes.

3. Move the width guides to the edges of the tray.
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Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface.
This procedure separates any sheets that are stuck together and reduces the possibility of jams.

Note: To avoid jams and misfeeds, do not remove paper from its packaging until you are ready to
use it.

Load the paper in the tray. Load hole-punched paper with the holes to the left.

—  For 1-sided printing, load letterhead or pre-printed paper face up with the top edge going into
the printer.

—  For 2-sided printing, load letterhead and pre-printed paper face down with the top edge going

into the printer.

Note: Do not load paper above the maximum fill line. Overfilling the tray can cause the printer
to jam.
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6.

108

Adjust the width guides until they touch the edges of the paper.

AN

If the control panel prompts you, verify the size, type, and color on the screen. If you are not
prompted, change the paper settings.

a. At the printer control panel, press the Home button.

b. Touch Device > Paper Trays.

c. Inthe Paper Trays menu, touch the bypass tray icon.
e Toselect apaper or envelope size, touch the current size setting, then select a size.
e Toselect apaper type, touch the current paper type, then select a paper type.
e Toselect apaper color, touch the current paper color, then select a paper color.

d. To save the settings, touch OK.

To return to the Home screen, press the Home button.
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Configuring Trays 1 or 2 for the Paper Length

You can adjust the lengths of trays 1 and 2 to accommodate A4, Letter (8.5 x 11 in.), and Legal
(8.5 x 14 in.) paper sizes. In the Legal length settings, the trays protrude from the front of the printer.

To change Trays 1 and 2 to match the paper length:
1. Remove all paper from the tray.

2. Toremove the tray from the printer, pull out the tray until it stops, lift the front of the tray slightly,
then pull it out.

3. Configure the tray.

—  To compress the tray for shorter paper, hold the back of the tray with one hand. With the other
hand, press the release latch at the front of the tray, then push the ends inward until they latch.

—  To extend the tray for longer paper, hold the back of the tray with one hand. With the other
hand, press the release latch at the front of the tray and pull the ends outward until they latch.

— To extend the tray, hold the back of the tray with one hand. With the other hand, press the
release latch at the front of the tray and pull the ends outward until they latch.
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Printing on Special Paper

This section includes:
O ENVLOPES ..ottt s AR 110
O L ODIS ettt et s st e et s ettt e bt s e e ae st e e ste e ae s sasaseaeaesetsasaesaeaesenas 114

To order paper or other media, contact your local reseller or visit www.xerox.com/office/VLC400supplies.

For reference:
www.xerox.com/rmlna Recommended Media List (United States)
www.xerox.com/rmleu Recommended Media List (Europe)

Envelopes

You can print envelopes from the bypass tray only.

Guidelines for Printing Envelopes

e Use only paper envelopes.
e Do not use envelopes with windows or metal clasps.

e  Print quality depends on the quality and construction of the envelopes. If you do not get the desired
results, try another envelope brand.

e  Maintain constant temperatures and relative humidity.

e  Store unused envelopes in their packaging to avoid excess moisture and dryness which can affect
print quality and cause wrinkling. Excessive moisture can cause the envelopes to seal before or
during printing.

e  Remove air bubbles from the envelopes before loading them into the tray by setting a heavy book
on top of them.

e Inthe print driver software, select Envelope as the paper type.

e Do not use padded envelopes. Use envelopes that lie flat on a surface.

¢ Do not use envelopes with heat activated glue.

¢ Do not use envelopes with press and seal flaps.
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Loading Envelopes in the Bypass Tray
1. Open the bypass tray.

2.  Move the width guides to the edges of the tray.

Note: If you do not load envelopes in the bypass tray right after they have been removed from the
packaging, they can bulge. Flatten them to avoid jams.

3. Toload envelopes, select an option:

—  For Number 10 envelopes, load the envelopes with the short edge going into the printer, flaps
down, and flaps to the right.
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—  For Monarch or DL envelopes, do one of the following. If the envelopes wrinkle, try
another option.

e Insert envelopes with the short edge going into the printer, flaps down, and flaps to
the right.

e Insert envelopes with the print side up, flaps open and down, and the bottom of the
envelope going into the printer.

~

e Insert the envelopes with the short edge feeding into the printer, flaps down, and flaps to
the right.

—  For C5 envelopes, do one of the following steps. If the envelopes wrinkle, try the other option.
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e Insert envelopes with the print side up, flaps open and down, and the bottom of the
envelope going into the printer.

Note: For envelopes to print correctly, when you load envelopes with the flaps open, in the print
driver, select Portrait, Landscape, or Rotated Landscape, as needed. To flip the images, in the print
driver, select Rotate Image 180 Degrees.

If the control panel prompts you, verify the size, type and color on the screen. If you are not
prompted, change the paper settings.
a. At the printer control panel, press the Home button.
b. Touch Device > Paper Trays.
¢. Inthe Paper Trays menu, touch the bypass tray icon.
e Toselect an envelope size, touch the current size setting, then select an envelope size.
e Toselect apaper type, touch the current paper type, then select envelope.
e Toselect an envelope color, touch the current paper color, then select an envelope color.
d. To save the settings, touch OK.
To return to the Home screen, press the Home button.
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Labels

You can print labels from the bypass tray only.

Guidelines for Printing Labels

A\

114

Use labels designed for laser printing.

Do not use vinyl labels.

Do not feed a sheet of labels through the printer more than once.

Do not use dry gum labels.

Print only on one side of the sheet of labels. Use full sheet labels only.

Store unused labels flat in their original packaging. Leave the sheets of labels inside the original
packaging until ready to use. Return any unused sheets of labels to the original packaging and
reseal it.

Do not store labels in extremely dry or humid conditions or extremely hot or cold conditions. Storing
them in extreme conditions can cause print-quality problems or cause them to jam in the printer.

Rotate stock frequently. Long periods of storage in extreme conditions can cause labels to curl and
jam in the printer.

In the print driver software, select Label as the paper type.
Before loading labels, remove all other paper from the tray.

CAUTION: Do not use any sheet where labels are missing, curled, or pulled away from the backing
sheet. It could damage the printer.
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Loading Labels in the Bypass Tray

1.  Remove all paper from the bypass tray.

2. Load Labels in the bypass tray, face up, with the top edge of the page feeding into the printer first.
3. Adjust the width guides until they touch the edges of the paper.

4. If the control panel prompts you, verify the size, type and color on the screen. If you are not
prompted, change the paper settings.

a. At the printer control panel, press the Home button.
b. Touch Device > Paper Trays.
c. Inthe Paper Trays menu, touch the bypass tray icon.
e Toselect apaper size, touch the current size setting, then select a size.
e Toselect a paper type, touch the current paper type, then select labels.
e Toselect apaper color, touch the current paper color, then select a paper color.
d. To save the settings, touch OK.
5.  Toreturn to the Home screen, press the Home button.

Xerox® VersalLink® C400 Color Printer 115
User Guide






Maintenance

This chapter includes:

General Precautions 118
CleaNING the PHNEET ..ottt s sss s sss s s s s s s s s s s ss s s s sssnsssnsens 119
Adjustments and MaiNtENANCE PrOCEAUIES ...t sssssssssssssssssssssssssssssssssssssssssssssnses 129
SUPPLIES ettt s st sss s s s bt ba s b s b s s b s s b st s b S bR s b b S ee b e bbb Rt b s b s e b At b e bt enen 132
MANAGING TNE PIINELET ..ottt ssssssssss s sssssssess s s sss s s s s s s ssssssssasssesssessssnsans 136
Moving the Printer 137

Xerox® Versalink® C400 Color Printer 117
User Guide



Maintenance

General Precautions

A\

> B
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CAUTION: When cleaning your printer do not use organic or strong chemical solvents or aerosol
cleaners. Do not pour fluids directly into any area. Use supplies and cleaning materials only as
directed in this documentation.

WARNING: Keep all cleaning materials out of the reach of children.

WARNING: Do not use pressurized spray cleaning aids on or in the printer. Some pressurized
sprays contain explosive mixtures and are not suitable for use in electrical applications. Use of
pressurized spray cleaners increases the risk of fire and explosion.

WARNING: Do not remove the covers or guards that are fastened with screws. You cannot
maintain or service any parts that are behind these covers and guards. Do not attempt any
maintenance procedure that is not described in the documentation supplied with your printer.

WARNING: Internal parts of the printer can be hot. Use caution when doors and covers are open.

Do not place anything on top of the printer.

Do not leave the covers and doors open for any length of time, especially in well-lit places.
Light exposure can damage the drum cartridges.

Do not open covers and doors during printing.
Do not tilt the printer while it is in use.

Do not touch the electrical contacts or gears. Doing so could damage the printer and cause the print
quality to deteriorate.

Ensure that any parts removed during cleaning are replaced before you plug in the printer.
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Cleaning the Printer

This section includes:
o Cleaning the EXLerior Of the PrINLET ...t ssss st ssssssssssssssssssssssssssssnns 119
O CledNiNG the INTEIION .ttt st sas s b s st s s bbb e st s s sas b s st s s sssnsans 119

Cleaning the Exterior of the Printer

Clean the exterior of the printer once a month.
e  Wipe the paper tray, output tray, control panel, and other parts with a damp, soft cloth.
e  After cleaning, wipe with a dry, soft cloth.

e  For stubborn stains, apply a small amount of mild detergent to the cloth and gently wipe the
stain off.

Cleaning the Interior

Clean the interior of the printer reqularly to prevent stains inside the printer that can deteriorate print
quality. Clean the printer interior whenever you replace a drum cartridge.

After clearing paper jams or replacing a toner cartridge, inspect inside the printer before closing the
printer covers and doors.

e Remove any remaining pieces of paper or debris. For details, refer to Clearing Paper Jams on
page 147.

e Remove any dust or stains with a clean, dry, lint-free cloth.

/1, WARNING: Never touch a labeled area on or near the heat roller in the fuser. You can
get burned. If a sheet of paper is wrapped around the heat roller, do not try to remove
it immediately. Power off the printer immediately and wait 40 minutes for the fuser to
cool. Try to remove the paper jam after the printer has cooled.

Cleaning the Laser Lenses

If prints have voids or light streaks through one or more colors, use the following instructions to clean the
laser lenses.
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/1, WARNING: If you accidentally get toner on your clothes, lightly dust them off as best as you can.
If some toner remains on your clothes, use cool water, not hot, to rinse off the toner. If toner gets
on your skin, wash it off with cool water and a mild soap. If you get toner in your eyes, wash it out
immediately with cool water and consult a doctor.

/1, CAUTION: Be careful not to spill toner when handling the waste cartridge.

1.  Power off the printer.

2. Remove the waste cartridge:
a. Open the right side door.

b.

120 Xerox® VersalLink® C400 Color Printer
User Guide



Maintenance

c.  Grasp the handle of the waste cartridge, then pull it out. To prevent toner spills, keep the
openings of the cartridge facing up.

Notes:

e  Be careful not to spill toner when handling the waste cartridge.
e  After removing the waste cartridge, do not touch the area shown in the illustration.

d.
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3. Clean the laser lenses:
a. Remove the cleaning rod from inside of the printer.

b. Insert the cleaning rod into one of the four cleaning holes until it stops, then move the rod in
and out to the full extent two more times.

c. Repeat the procedure for the holes in the other three slots.
d. Return the cleaning rod to its original location.
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4. Insert the waste cartridge.

Note: If the waste cartridge does not fit into place properly, ensure that the cleaning rod is
inserted fully.

a. Tolock the waste cartridge, rotate the waste cartridge lock lever 90 degrees clockwise.

b.
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Cleaning the Color Toner Density Sensor
If the print or color density is too light, missing, or the background is foggy, clean the density sensor.

To clean the color toner density sensor:
1. Power off the printer.

2. Push down on the rear door release and pull open the door.

3. Remove the waste cartridge:
a. Open the right side door.
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b. To unlock the waste cartridge, rotate the waste cartridge lever 90 degrees counterclockwise.

c.  Grasp the handle of the waste cartridge, then pull it out. To prevent toner spills, keep the
openings of the cartridge facing up.

Notes:

e  Be careful not to spill toner when handling the waste cartridge.
e  After removing the waste cartridge, do not touch the area shown in the illustration.

d.
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/1, CAUTION: To avoid toner spills or malfunction, do not lay the waste cartridge on its side

4. Clean the color toner density sensor:
a. Open the top cover.

b. Grasp the handles on the top of the transfer belt, then pull to remove it from the printer.

c. Atthe rear of the printer, use a dry cotton swab to clean the color toner density sensor.
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d. Atthe front of the printer, reinsert the transfer belt into the printer.

e. Close the top cover.

5. Insert the waste cartridge.

Note: If the waste cartridge does not fit into place properly, ensure that the cleaning rod is
inserted fully.

a. Tolock the waste cartridge, rotate the waste cartridge lock lever 90 degrees clockwise.

Xerox® VersalLink® C400 Color Printer 127
User Guide



Maintenance

b. Close the right side door.

6. Close the rear door.
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Adjustments and Maintenance Procedures

This section includes:

®  COLOT REGISTIATION .ottt sssess s asss s s s s s s st sss s s st ses st sesssasssasessssssnsens 129
o Performing A Color CaliDrOION ...ttt sess s s ssssesssssssesssssssssssssssssssssssssssssssssssssssssssssansenns 129
o  Adjusting PAPEr REGISTIALION .......ovveerierreerieriesiesiss st isssissssssssssssstssessssssssssssssssssssssssssssasssssssssssssssssssssnssssssssens 130

Color Registration

The printer automatically adjusts the color registration when automatic adjustment is turned on.
You can also adjust color registration manually any time the printer is idle. You must adjust the
color registration any time the printer is moved. If you are having printing problems, adjust the
color registration.

Performing a Color Registration Adjustment

A color registration adjustment occurs every time a new toner cartridge is installed. You can run this
adjustment at other times as needed.

To perform a color registration adjustment:

At the printer control panel, press the Home button.

Touch Device > Support > Color Registration.

To perform an Automatic Color Registration adjustment, touch Start.
At the successfully completed prompt, touch Close.

To exit the menu, touch X.

o bk whN =

To return to the Home screen, press the Home button.

Performing a Color Calibration

The Color Calibration procedure is performed using the Embedded Web Server.

To perform a manual Color Calibration:
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then
press Enter or Return.

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your
Printer on page 30.

Click System, then click Defaults & Policies.

Click Manual Color Adjustment.

Adjust the Photo and Text color levels as required.

To save the settings, click OK.

e whN
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Adjusting Paper Registration

Use Adjust Paper Registration to adjust the placement of the printed image on the page. The
adjustment allows you to place the top, bottom, left, and right margins exactly where you want.
You can specify the image position on both the front and back sides of the paper, for each installed
paper tray.

Verifying Paper Registration

1.

2.
3.
4

At the printer control panel, press the Home button.

Log in as administrator. For details, refer to Logging In as the Administrator.

Touch Device > Support > Image Position.

Select the source paper tray for the registration print.

a. Touch Paper Supply.

b. Touch the desired tray.

If your printer has automatic 2-sided printing, select the sides that you want to optimize.

—  To select a sample registration page for adjusting side 1, touch Adjusted Side, then touch
Side 1.

—  Toselect a sample registration page for adjusting both sides, touch Adjusted Side, then touch
Side 2.

Specify the consecutive number of sample pages to print.
a. Touch Print Settings.

b. To increase or decrease the number of sample pages, for Quantity, touch Plus (+) or Minus (-),
then touch OK.

To print the sample pages, touch Print Sample.

When printing is completed, touch Close.

On the sample pages, for Side 1, use a ruler to measure the distance of the printed image from the
top, bottom, left, and right edges.

Note: For identification, a single dot is printed on Side 1, and two dots are printed on Side 2.

10. For Side 2, measure the distance of the printed image from the top, bottom, left, and right edges.
11. If the image is centered, no adjustment is required. If not centered, adjust the paper registration.

130

For details, refer to Performing a Paper Registration Adjustment on page 131.
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Performing a Paper Registration Adjustment

1.

2.
3.
4

7.
8.
9.

At the printer control panel, press the Home button.

Log in as administrator. For details, refer to Logging In as the Administrator.

Touch Device > Support > Image Position.

To adjust registration, select the source paper tray.

a. Touch Paper Supply.

b. Touch the desired tray.

Using the chart printed in Verifying Paper Registration, select the side for registration.

a. For adjusting Side 1, touch Adjusted Side, then touch Side 1.

b. For adjusting Side 2, touch Adjusted Side, then touch Side 2.

To adjust the registration, touch Lead/Side Registration.

a. To adjust the side-to-side registration, for Side Registration, touch Plus (+) or Minus (-).

b. To adjust the top-to-bottom registration, for Lead Registration, touch Plus (+) or Minus (-).
For reference, position the chart so that Side-1 or Side-2 dots are at the bottom of the page.
e  For Lead Registration, a positive value shifts the image down the page.
e  For Side Registration, a positive value shifts the image to the left.

To save your settings, touch OK.
As needed, repeat steps 4 through 6 to enter additional values.
Print another sample page, then repeat the process until you complete the registration corrections.

10. To return to the Home screen, press the Home button.
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Supplies

This section includes:

©  CONSUMADLES ..ottt e s st s s bbb s a s bbb b sas b sassassassassansansanes 132
o ROULINE MAINTENANCE TEOMIS ...ttt s st st s st s st s s s s sansanen 132
®  OrAErING SUPPLES ..ottt tsssss st ssssssss s ssssssssss st s s s bbb s s b s bas s as b e s bas st s s s st s sass b ssssbensens 133
O TONET CAMIIAGES...eierrierreeeireis sttt sessssss s ssses e s s st sesssa s s s s et sesss e s st e sssasessasesasessesssessnsasessnsanes 135
®  RECYCING SUPPLES ...ttt ssss s s s s sas s bbb s b bbb e b s bbb st b b s b s s s s bans 135
Consumables

Consumables are printer supplies that get depleted during the operation of the printer. Consumable
supplies for this printer are the Genuine Xerox® Toner Cartridges in Cyan, Magenta, Yellow, and Black.

Notes:

e  Each consumable includes installation instructions.

e Install only new cartridges in your printer. If a used toner cartridge is installed, then the toner
remaining amount displayed could be inaccurate.

e To ensure print quality, the toner cartridge has been designed to cease functioning at a
predetermined point.

CAUTION: Use of toner other than genuine Xerox® Toner can affect print quality and printer
reliability. Xerox® Toner is the only toner designed and manufactured under strict quality controls
by Xerox for specific use with this printer.

Routine Maintenance Items

Routine maintenance items are printer parts that have a limited life and require periodic replacement.
Replacements can be parts or kits. Routine maintenance items are typically customer replaceable.

Note: Each routine maintenance item includes installation instructions.

Routine maintenance items for this printer include the following:

e  Drum Cartridge Kit

e  Waste Cartridge

¢  Maintenance Kit, which includes a Transfer Belt, Transfer Roller and Feed Roller
e Fuser
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Ordering Supplies

When to Order Supplies

A warning appears on the control panel when supplies near their replacement time. Verify that you
have replacements on hand. It is important to order these items when the messages first appear to
avoid interruptions to your printing. An error message appears on the control panel when supplies
must be replaced.

Order supplies from your local reseller or go to www.xerox.com/office/VLC400supplies.

/1, CAUTION: Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service
Agreement, and Total Satisfaction Guarantee do not cover damage, malfunction, or
degradation of performance caused by use of non-Xerox supplies, or the use of Xerox
supplies not specified for this printer. The Total Satisfaction Guarantee is available in the
United States and Canada. Coverage could vary outside these areas. Please contact your
Xerox representative for details.

Supply Status

You can check the status and percentage of life remaining for your printer supplies at the control panel
or from the Embedded Web Server. When printer supplies near their replacement time, warning alerts
appear on the control panel. You can customize the alerts that appear on the control panel and
configure email alert notifications.

To check the supplies status at the control panel:
1. To view status information for the printer supplies, touch Device > Supplies.

2. To view details about a specific item, including its part number for reordering, touch the
desired item.

3. Toreturn to the Supplies screen, touch X.
4.  Toreturn to the Device screen, touch the back arrow.

To customize supplies alert settings:
1. To customize the alerts that appear for printer supplies, touch Device > Supplies > Alerts Setup.
2. To enable supplies alerts, touch the Enable Alerts toggle button.

3. To configure the printer to display an alert when an item reaches a specific usage percentage level,
touch the item, then select the percentage.

4. To customize the alerts for each supply item, to enable or disable an alert, touch the toggle button.
5.  Toreturn to the Supplies screen, touch X.
6. Toreturn to the Device screen, touch the back arrow.
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To set up email alerts:
1. Toset up alerts to send to an email address, touch Device > Supplies > Email Alerts.
2. To enter an email address, touch Add Email, then touch Enter Email Address.

3. Use the touch screen keyboard to enter an email address, or select an entry from the Address Book,
then touch OK.

Add more email addresses if necessary.

To customize the alerts for each supply item, to enable or disable an alert, touch the toggle button.
To exit the menu, touch OK.

7. Toreturn to the Device screen, touch the back arrow.

o v e

To check the supplies status and set up alerts using the Embedded Web Server, refer to the System
Administrator Guide at www.xerox.com/office/VLC400docs.

Supplies Usage Report

The Supplies Usage Report provides coverage information and part numbers for reordering supplies.
The date a supply item was installed also appears on the report.

To print the Supplies Usage Report:

1. At the printer control panel, press the Home button.

2. Touch Device > About > Information Pages.

3. Touch Supplies Usage Report.

4. Toreturn to the Home screen, press the Home button.
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Toner Cartridges

This section includes:
O GONETAL PrOCAULIONS et teee s e aetes s asesesssess s sssssssesasassasasasssasssssssassasasassasassesasasassassssesas 135
o Replacing A TONET CAtFIAGE ......mrerireeeereireisrissesesessisessssss s sssssssssssssssssssssssssssssssssssssssssssssssssssssssssassssssssesens 135

General Precautions

/I WARNINGS:

e  When replacing a toner cartridge, be careful not to spill the toner. If any toner spills, avoid
contact with clothes, skin, eyes, and mouth. Do not inhale the toner dust.

o  Keep toner cartridges out of the reach of children. If a child accidentally swallows toner,
have the child spit out the toner, and rinse out their mouth with water. Consult a
physician immediately.

/1, WARNING: Use a damp cloth to wipe off spilled toner. Never use a vacuum cleaner to remove

spills. Electric sparks inside the vacuum cleaner can cause a fire or explosion. If you spill a large
volume of toner, contact your local Xerox representative.

/1, WARNING: Never throw a toner cartridge into an open flame. Remaining toner in the cartridge
can catch fire and cause burn injuries or an explosion.

Replacing a Toner Cartridge

A message appears on the control panel when a toner cartridge must be replaced.

Note: Each toner cartridge includes installation instructions.

Printer Status Message Cause and Solution
Reorder Toner The toner cartridge is low. Order a new toner cartridge.
Out of Toner The toner cartridge is empty. Replace the toner cartridge with a new one.

Recycling Supplies

For more information on the Xerox® supplies recycling program, go to: www.xerox.com/gwa.
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Managing the Printer

This section includes:
o Viewing the Meter REAAING...... ettt ssss st s s sssessssssssssassssssssesens 136
o  Printing the Billing SUMMAIY REPOI ...ttt sss s sss s sssssssssssssssssssssssessssssassesssens 136

Viewing the Meter Reading

The Billing/Usage menu displays the total number of impressions that the printer generated or printed
during its lifetime. You cannot reset the counters. A page is counted as one side of a sheet of paper.
For example, a sheet of paper that is printed on two sides counts as two impressions.

Note: If you provide regular billing information for your device, you can use the Remote Services Upload
feature to simplify the process. You can enable Remote Services to send billing meter readings to

Xerox automatically so that you do not have to collect the readings manually. Refer to the System
Administrator Guide for further information.

To view the billing information for your printer:

1. At the printer control panel, press the Home button.

2. Touch Device > Billing/Usage.

3. To view more details, touch Usage Counters and select an option.

4.  After viewing the usage readings, to return to the Home screen, press the Home button.

Printing the Billing Summary Report

The Billing Summary Report provides information about the device and a detailed listing of the billing
meters and sheet counts.

To print the Billing Summary Report:

1. At the printer control panel, press the Home button.

2. Touch Device > About > Information Pages.

3. Touch Billing Summary Report.

4. Toreturn to the Home screen, press the Home button.
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Moving the Printer

/A WARNINGS:

e To lift the printer, always use at least two people to grasp the hand holds on each
side of the printer.

e To prevent you from dropping the printer or injury, lift the printer firmly by gripping
the recessed areas on both sides of the printer. Never lift the printer by gripping any
other areas.

e If the optional 550-Sheet Feeder is installed, uninstall it before you move the printer.
If the optional 550-Sheet Feeder is not fixed to the printer securely, it can fall to the
ground and cause injury.

Follow these instructions when moving the printer:
1. Power off the printer, then disconnect the power cord and other cables from the back of the printer.
_;i"»._ WARNING: To prevent electric shock, never touch the power plug with wet hands.

When removing the power cord, ensure that you pull the plug and not the cord.
Pulling the cord can damage it, which can lead to fire or electric shock.

2. Remove any paper or other media from the output tray. If the output tray extension is extended,
close it.

3. Remove the paper from the paper tray.
Keep the paper wrapped and away from humidity and dirt.
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4. Lift and carry the printer as shown in the illustration.

Notes:

e  When moving the printer, do not tilt it more than 10 degrees in any direction. Tilting the printer
more than 10 degrees can cause toner spillage.

e  When moving the printer over a long distance, remove the drum cartridge and toner cartridges
to prevent toner from spilling.

& CAUTION: Failure to repackage the printer properly for shipment can result in damage
not covered by the Xerox® Warranty, Service Agreement, or Total Satisfaction Guarantee.
The Xerox® Warranty, Service Agreement, or Total Satisfaction Guarantee do not cover
damage to the printer caused by improper moving.

After moving the printer:

1. Reinstall any parts that you removed.

2. Reconnect the printer to the cables and power cord.
3. Plug in and power on the printer.
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This chapter includes:

e  General Troubleshooting 140
O PAPOE JAMS .ottt sa s s s s e b snsns 145
®  Print-QUALILY PrODIEMS ..ottt sessssss st ssss s ssssssssssssssssssssssssssssssssessssssssssssssssssssnsssnes 159
e  Getting Help 166

Xerox® VersalLink® C400 Color Printer 139
User Guide



Troubleshooting

General Troubleshooting

This section includes:

PriNtEr DOES INOT POWET Ottt et sessssas s s s sesetsassssesssesssenetetesssasasasssasasasasssasaens

Printer Resets or POWErS Off FIEQUENTLY ...ttt ssssssssessssssesssssssesssssssssssssssanns
PriNTEr DOES NOT PriNT....cu ettt s sttt st sttt ssecies
PriNting TAKES TOO LONG ...ttt cssessssssssssas st ssss s sssssssssssssssssssssessssssssssssssssssssssssssssssssssssans
Document Prints From Wrong Tray
Automatic 2-Sided Printing PrODIEMIS ...ttt ssstssssssssssssssssssssssssssssssssssssnsssssssssansens
Printer is Making UNUSUGL NOISES..........viereerrereissireisineissssis st ssssssessssssssssssssssssssssssssssssssssssssssssssssssssaes
PAPET TIAY WIll NOT CLOSE ..ottt sssissesssestessesstssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnsssssssssssssssssssnssanns
Condensation has Formed INSide the Printer........ e esseeaeeeanee

This section contains procedures to help you locate and resolve problems. Resolve some problems by
simply restarting the printer.

Printer Does Not Power On

Probable Causes Solutions

The power switch is not turned on. At the printer control panel, press the Power/Wake button.
For details, refer to Powering On and Off the Printer.

The power cord is not plugged into the Power off the printer, and plug the power cord securely into

outlet correctly. the outlet.

The printer requires a full reset. Power off the printer, then unplug the power cord and wait 30

seconds. Plug the power cord into the outlet securely, then press
the Power/Wake button.

Something is wrong with the outlet e Plug another electrical appliance into the outlet and check if it
connected to the printer. operates properly.

e Try adifferent outlet.

The printer is connected to an outlet with a Use a power source with the specifications listed in the Electrical
voltage or frequency that does not match the | Specifications on page 175.
printer specifications.

140

/1, CAUTION: Plug the three-wire cord with grounding prong directly into a grounded AC outlet.
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Printer Resets or Powers Off Frequently

Probable Causes Solutions

The power cord is not plugged into the
outlet correctly.

Power off the printer, confirm that the power cord is plugged in
correctly to the printer and the outlet, then power on the printer.

A system error occurred.

Power off the printer, then power on again. Print the Error History
Report. For details, refer to Printing the Error History Report on page
167. If the error persists, contact your Xerox representative.

The printer is connected to an uninterruptible
power supply.

Power off the printer, then connect the power cord to a
suitable outlet.

The printer is connected to a power strip
shared with other high-power devices.

Plug the printer directly into the outlet or into a power strip that is
not shared with other devices.

The Auto Power Off feature is enabled to
save power.

Increase the Auto Power Off timer setting or disable the Auto
Power Off feature. For details, refer to the System Administrator
Guide at www.xerox.com/office/VLC400docs.

Printer Does Not Print

Probable Causes Solutions

The printer is in Power Saver mode.

On the control panel, press the Power/Wake button.

The printer has an error.

If the Status LED is blinking amber, follow the instructions on the
control panel to clear the error. If the error persists, contact your
Xerox representative.

The printer is out of paper.

Load paper into the tray.

The incorrect paper is loaded for the
print job.

Load the correct paper in the appropriate tray. On the printer
control panel, specify the correct paper size, type and color.

The paper settings for the print job do not
match any paper loaded in the paper trays at
the printer.

From the print driver, select a paper tray containing the
correct paper.

A toner cartridge is empty.

Replace the empty toner cartridge.

No control panel indicators are lit.

Power off the printer, confirm that the power cord is plugged in
correctly to the printer and the outlet, then power on the printer.
If the error persists, contact your Xerox representative.

The printer is busy.

e If the Status LED is flashing blue, a previous print job could be
the problem.
a. At your computer, use the printer properties to delete all
print jobs in the print queue.
b. At the control panel, touch Jobs, then delete all pending
print jobs.
e Load the paper in the tray.
e If the Status LED does not flash once after you send a print job,

check the connection between the printer and the computer.
Power off the printer, then power on.

The printer cable is disconnected.

If the Status LED does not flash once after you send a print job,
check the connection between the printer and the computer.
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Probable Causes Solutions

There is a network-connectivity issue. If the printer is connected to a network:

a. Verify that the Ethernet cable is connected to the printer.

b. On the printer Ethernet connector, verify that the green LED
is On. If not, reseat both ends of the Ethernet cable.

C. Examine the TCP/IP address in the Communication section
of the Configuration Report. For details, refer to Printing the
Configuration Report on page 29.

d. If the TCP/IP address is 0.0.0.0, the printer needs more time
to acquire an IP address from the DHCP server. Wait 2
minutes, then print the Configuration Report again.

e. If the TCP/IP address is unchanged, or begins with 169,
contact your network administrator.

There is a wireless network setup or Verify that the Wireless Network Adapter is installed and properly
connectivity issue. configured. For details, refer to Connecting to a Wireless Network
on page 34.

Printing Takes Too Long

Probable Causes Solutions

The printer is set to a slower printing mode. | It takes more time to print on certain types of special paper. Ensure
For example, the printer could be set to print | that the paper type is set properly in the driver and at the printer

on Heavyweight paper. control panel. For details, see Print Speed on page 177.

The printer is in Power Saver mode. It takes time for printing to start when the printer is coming out of
Power Saver mode.

The way the printer was installed on the Determine if a print spooler or a computer sharing the printer is

network could be an issue. buffering all print jobs and then spooling them to the printer.

Spooling can slow print speeds. To test the speed of the printer,
print some information pages such as the Office Demo Page. If the
page prints at the rated speed of the printer, you could have a
network or printer installation issue. For additional help, contact the
system administrator.

The job is complex. Wait. No action needed.

The print-quality mode in the driver is set Change the print-quality mode in the print driver to Standard.
to Enhanced.
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Document Prints From Wrong Tray

Probable Causes Solutions

Application and print driver have conflicting | 1. Check the tray selected in the print driver.

tray selections. 2. Go to the page setup or printer settings of the application from
which you are printing.

3. Set the paper source to match the tray selected in the print
driver or set the paper source to Automatically Select.

Note: To have the print driver select the tray, set the tray used as
the paper source to Auto Selection Enabled.

Automatic 2-Sided Printing Problems

Probable Causes Solutions

Unsupported or incorrect paper. Ensure that you are using a supported paper size and weight for
2-sided printing. Envelopes, cardstock, and labels cannot be used for
2-sided printing. For details, refer to Supported Standard Types and
Weights for Automatic 2-Sided Printing.

Your printer model is not configured with Ensure that your printer supports automatic 2-sided printing. For
automatic 2-sided printing. details, refer to Printer Configurations and Options on page 170.
Incorrect setting. In the print driver Printing Options tab, select 2-Sided Print.

Printer is Making Unusual Noises

Probable Causes Solutions
There is an obstruction or debris inside Power off the printer and remove the obstruction or debris. If you
the printer. cannot remove it, contact your Xerox representative.

Paper Tray Will Not Close

Probable Causes Solutions

The paper tray does not fully close. e If the tray is extended for legal-size paper, the tray protrudes
when it is inserted into the printer. For details, refer to
Configuring Trays 1 or 2 for the Paper Length.

e Some debris or an object is blocking the tray.

e The tray is hanging up on the table or shelf on which it
is located.

e At the back of the paper tray, push the paper lift down until it
clicks into place. Insert the tray into the printer. If the paper lift
does not click into place correctly, replace the paper tray.

Xerox® Versalink® C400 Color Printer 143
User Guide



Troubleshooting

Condensation has Formed Inside the Printer

Moisture can condense inside a printer where the humidity is above 85 % or when a cold printer is
located in a warm room. Condensation can form in a printer after it has been sitting in a cold room that

is heated quickly.

Probable Causes

Solutions

The printer has been sitting in a cold room.

Allow the printer to operate for several hours at room temperature.

The relative humidity of the room is too high.

e Reduce the humidity in the room.

e Move the printer to a location where the temperature and
relative humidity are within the operating specifications.
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Paper Jams

This section includes:

®  LOCALING PAPEE JAMS ...ttt eese sttt sttt sttt s s bbb bbbt aseaneaes 145
®  MiNIMIZING PAPET JAMIS ...ttt sttt s s s ssssasssssssssssssssssssssesssssessssesssnsssssssansanen 146
®  Clearing PAPEE JAMS.......ieeerieeisseseie s sssstssssss s ssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnssssssssssssssssssssssenns 147
e TroubleshOOting PAPEI JAMS ...ttt sssssss st ssssssssssssssssssssssssssssssassssssssesans 157

Locating Paper Jams

/1, WARNING: Never touch a labeled area on or near the heat roller in the fuser. You can get
burned. If a sheet of paper is wrapped around the heat roller, do not try to remove it
immediately. Power off the printer immediately and wait 40 minutes for the fuser to cool.
Try to remove the jam after the printer has cooled. If the error persists, contact your Xerox
representative.

/1, CAUTION: Do not attempt to clear any paper jams using tools or instruments. This can
permanently damage the printer.

The following illustration shows where paper jams can occur along the paper path:

1. Tray 2 3. Bypass Tray
2. Fuser 4. Tray 1
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Minimizing Paper Jams

The printer is designed to function with minimal paper jams using Xerox supported paper. Other paper
types can cause jams. If supported paper is jamming frequently in one areq, clean that area of the
paper path.

The following can cause paper jams:

Selecting the incorrect paper type in the print driver.
Using damaged paper.

Using unsupported paper.

Loading paper incorrectly.

Overfilling the tray.

Adjusting the paper guides improperly.

Most jams can be prevented by following a simple set of rules:

Use only supported paper. For details, refer to Supported Paper on page 98.
Follow proper paper handling and loading techniques.

Always use clean, undamaged paper.

Avoid paper that is curled, torn, moist, creased, or folded.

To separate the sheets before loading into the tray, fan the paper.

Observe the paper tray fill line; never overfill the tray.

Adjust the paper guides in all trays after inserting the paper. A guide that is not properly adjusted
can cause poor print quality, misfeeds, skewed prints, and printer damage.

After loading the tray, at the control panel, select the correct paper type and size.
When printing, select the correct type and size in the print driver.
Store paper in a dry location.

Avoid the following:

Polyester coated paper that is designed especially for inkjet printers.

Paper that is folded, wrinkled, or excessively curled.

Loading more than one type, size, or weight of paper in a tray at the same time.
Overfilling the tray.

Allowing the output tray to overfill.

For a detailed list of supported paper, go to www.xerox.com/rmlna.
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Troubleshooting

Clearing Paper Jams

This section includes:

o  Clearing Paper Jams from the BYPASS TIAY .....ccevrrrerrirerensiesenssnsisssensssssssssssssssssssssssssssssssssssssssssssssssssssssans 147
o  Clearing Paper Jams from the TraY T ATQ ... reeceeseeseeresssisssssssssssssssssssssssssssssssssssssssssssssssssssssssssnns 150
o  Clearing Paper Jams from the TrAY 2 AT@Q......eenreeceseeerenssesssissssssssssssssssssssssssssssssssssssssssssssssssssssanes 153
o Clearing Paper JAmS from the FUSEE ATEa ......eeereeierssississsesiessessissssssssssssssssssssssssssssssssssssssssssssssssssssssans 155

Clearing Paper Jams from the Bypass Tray

To resolve the error that appears on the control panel, clear all paper from the paper path.
1. Remove any paper from the Bypass Tray.

2.
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3. Pullout Tray 1 until it stops.

4,

5. Remove the jammed paper.

6.
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Note: If the tray is extended for legal-size paper, the tray protrudes when it is inserted into
the printer.

7. Insert the Bypass Tray completely into the printer.

8. When paper trays are set to Fully Adjustable, you are prompted to verify or change the
paper settings.

—  To confirm the same paper size, type, or color, touch OK.

— Toselect a new paper size, type or color, touch the current setting, then select a new setting.
When finished, touch OK.

9. Toreturn to the Home screen, press the Home button.
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Clearing Paper Jams from the Tray 1 Area

To resolve the error that appears on the control panel, clear all paper from the paper path.
1. Remove any paper from the Bypass Tray.

2.

3. Pullout Tray 1 until it stops.
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4. Toremove the tray, lift the front of it slightly, then pull it out of the printer.

5. Remove the jammed paper.

6. Remove any crumpled paper from the tray and any remaining paper jammed in the printer.
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7. Insert Tray 1 into the printer, then push it in all the way.

Note: If the tray is extended for legal-size paper, the tray protrudes when it is inserted into
the printer.

8. Insert the Bypass Tray completely into the printer.

9. When paper trays are set to Fully Adjustable, you are prompted to verify or change the
paper settings.

—  To confirm the same paper size, type, or color, touch OK.

— Toselect a new paper size, type or color, touch the current setting, then select a new setting.
When finished, touch OK.

10. Toreturn to the Home screen, press the Home button.
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Clearing Paper Jams from the Tray 2 Area

To resolve the error that appears on the control panel, clear all paper from the paper path.
1. Pull out Tray 2 until it stops.

2.

3. Remove any crumpled paper from the tray and any remaining paper jammed at the front of
the printer.
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4. Insert Tray 2 into the printer, then push it in all the way.

Note: If the tray is extended for legal-size paper, the tray protrudes when it is inserted into
the printer.

5. When paper trays are set to Fully Adjustable, you are prompted to verify or change the
paper settings.

—  To confirm the same paper size, type, or color, touch OK.

— Toselect a new paper size, type, or color, touch the current setting, select a new setting then
touch OK.

6. Toreturn to the Home screen, press the Home button.
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Clearing Paper Jams from the Fuser Area

To resolve the error that appears on the control panel, clear all paper from the paper path.
1. Push down on the rear door release and pull open the door.

—
—

2.

3.
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4. Remove any jammed paper from the back of the printer.
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5. Close the paper guide on the Fuser.

6. Lower the green levers to their original position.

7. Close the rear door.
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Troubleshooting Paper Jams

This section includes:

e  Multiple Sheets Pulled Together

e  Paper Misfeeds

e Label and Envelope Misfeeds

e  Paper Jam Message Stays On....
Jams During Automatic 2-Sided Printing

Multiple Sheets Pulled Together

Probable Causes Solutions

The paper tray is too full.

Remove some of the paper. Do not load paper past fill line.

The edges of the paper are not even.

Remove the paper, align the edges, and then reload it.

The paper is moist from humidity.

Remove the paper from the tray, and replace it with new dry paper.

Too much static electricity is present.

Try a new ream of paper.

Using unsupported paper.

Use only Xerox®-approved paper. For details, refer to Supported Paper on
page 98.

Humidity is too high for coated paper.

o Feed paper one sheet at a time.
e Try loading paper in the Bypass tray.

The feed rollers are dirty.

With a clean, lint-free cloth moistened with water, wipe the feed rollers
until they are clean. For details, refer to Cleaning the Printer on page 119.

Paper Misfeeds

Probable Causes Solutions

The paper is not correctly positioned in
the tray.

e Remove the misfed paper and reposition it properly in the tray.
o Adjust the paper guides in the tray to match the size of the paper.

The paper tray is too full.

Remove some of the paper. Do not load paper past the fill line.

The paper guides are not correctly
adjusted to the paper size.

Adjust the paper guides in the tray to match the size of the paper.

The tray contains warped or wrinkled
paper.

Remove the paper, smooth it out, and reload it. If it still misfeeds, do not
use that paper.

The paper is moist from humidity.

Remove the moist paper and replace it with new, dry paper.

Using paper of the wrong size,
thickness, or type.

Use only Xerox approved paper. For details, refer to Supported Paper on
page 98.

The feed rollers are dirty.

With a clean, lint-free cloth moistened with water, wipe the feed rollers
until they are clean. For details, refer to Cleaning the Printer on page 119.
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Label and Envelope Misfeeds

Probable Causes

Solutions

The label sheet is facing the wrong way in
the tray.

e Load label sheets according to the instructions from
the manufacturer.

e Load labels in the tray, face up.
For details, refer to Labels on page 114.

Labels are missing, curled, or pulled away
from the backing sheet.

Do not use any sheet where labels are missing, curled, or pulled
away from the backing sheet.

Envelopes are loaded incorrectly.

You can print envelopes from the Bypass tray or Tray 1.
For details, refer to Envelopes on page 110.

Envelopes are wrinkling.

e The heat and pressure of the laser printing process can
cause wrinkling.

e Use supported envelopes. For details, refer to Guidelines for
Printing Envelopes on page 110.

Note: When you load envelopes long-edge feed, ensure that you
specify landscape orientation in the print driver.

Paper Jam Message Stays On

Probable Causes

Solutions

Some paper remains jammed in the printer.

Recheck the media path and make sure that you have removed all
of the jammed paper.

One of the printer doors is open.

Check the doors on the printer. Close any door that is open.

Note: Check for, and remove, torn pieces of paper in the paper path.

Jams During Automatic 2-Sided Printing

Probable Causes

Solutions

Using paper of the wrong size, thickness,
or type.

Use paper of the correct size, thickness, or type. For details, refer to
Supported Paper Sizes for Automatic 2-Sided Printing.

Paper is loaded in the wrong tray.

Ensure that paper is loaded into the correct tray. For details, refer to
Supported Paper on page 98.

Tray is loaded with mixed paper.

Load the tray with only one type and size of paper.
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Print-Quality Problems

This section includes:

o Controlling PrinT-QUOLITY ......ovveieeeeereereieriseisiseis st sssesssssssss st sssesss s sssssssssssssssssesssssssssssssessssssssassssssssesens 159
O PAPET AN MEAIA ...ttt sessssss s sssssssssss s s s bass s sss st s ssss s s s b s s s sess s s ass b ssssssassssnbansens 160
o SolviNg Print-QUAlitY PrOBIEMIS. ...ttt sass st sss s ssssssss s sss st sssss s ssss s sesnsans 161

Your printer is designed to produce consistently high-quality prints. If you observe print-quality problems,
use the information in this section to troubleshoot the problem. For more information, go to
www.xerox.com/office/VLC400support.

/1, CAUTION: The Xerox Warranty, Service Agreement, or Xerox Total Satisfaction Guarantee
does not cover damage caused by using unsupported paper or specialty media. The Xerox
Total Satisfaction Guarantee is available in the United States and Canada. Coverage could
vary outside these areas. Contact your local Xerox representative for details.

Notes:

e To ensure consistent print quality, the toner/print/drum cartridges for many devices are
designed to cease functioning at a predetermined point.

e  Grayscale images printed with the composite black setting increment the color pages
counter, because color consumables are used. Composite black is the default setting on
most printers.

Controlling Print-Quality

Various factors can affect the quality of the output of your printer. For consistent and optimum
print quality, use paper designed for your printer, and correctly set the Print-Quality Mode and Color
Adjustments. Follow the guidelines in this section to maintain optimum print quality from your printer.

Temperature and humidity affect the quality of the printed output. The range for optimal print quality
is 15-28°C (59-82°F) and 20-70 % relative humidity. However, print quality can be affected when
operating near the limits for both temperature and humidity.
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Paper and Media

Your printer is designed to use various paper and other media types. Follow the guidelines in this section
for the best print quality and to avoid jams:

e Use only Xerox approved paper. For details, refer to Supported Paper on page 98.
e Use only dry, undamaged paper.

_;i"»._ CAUTIONS: Some paper and other media types can cause poor output quality, increased
paper jams, or damage your printer. Do not use the following:

e Rough or porous paper
o Inkjet paper
e Non-laser glossy or coated paper
o Paper that has been photocopied
o Paper that has been folded or wrinkled
e Paper with cutouts or perforations
o Stapled paper
e Envelopes with windows, metal clasps, side seams, or adhesives with release strips
e Padded envelopes
¢ Plastic media
e Transparencies
e  Ensure the paper type selected in your print driver matches the paper type on which you
are printing.
e If you have the same size paper loaded in more than one tray, ensure that the proper tray is
selected in the print driver.

e  Store your paper and other media properly for optimum print quality. For details, refer to Paper
Storage Guidelines on page 99.
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Solving Print-Quality Problems

Troubleshooting

When the print quality is poor, select the closest symptom from the following table and refer to the
corresponding solution to correct the problem. You can also print a Demonstration Print page to more
precisely determine the print-quality problem. For details, refer to Information Pages on page 28.

If the print quality does not improve after performing the appropriate action, contact your

Xerox representative.

Notes:

e  To maintain print quality, the toner or drum cartridges for many models of equipment are
designed to stop functioning at a predetermined point.

e  Grayscale images printed with the composite black setting increment the color-pages counter,
because color consumables are used. Composite black is the default setting on most printers.

Symptom

Probable Causes

Solutions

e Page Margins Are
Inconsistent.

e Theimage is not centered on
the page or the margins are

not consistent.
| o m a o oo,

A paper registration
adjustment is needed.

Use the paper registration procedure to adjust
the image position on the page. For details,
refer to Adjusting Paper Registration on

page 130.

Faded printouts with multiple
colors faded.

The toner cartridges are not
Xerox® toner cartridges.

Verify that the toner cartridges meet
specifications, and replace them if necessary.
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N T Ny
— N
/{ \\2f>

The paper being used is outside
the recommended
specification range.

Replace the paper with a recommended size
and type, and confirm that your control panel
and print driver settings are correct. For
details, refer to Supported Paper on page 98.

The paper type is heavier or
thicker than the paper
type selection.

e Ensure that the proper paper is loaded in
the paper tray.

e Choose a heavier paper type at the control
panel and in the print driver.

e Use alighter paper or paper type.
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Symptom

Probable Causes

The bias transfer voltage is not
properly adjusted for the

paper type.

Solutions

Verify that the paper types set in the control
panel and the print driver match the paper
loaded in the tray.

The settings in the application
or print driver are incorrect.

Print the Demonstration Print from the
Information Pages menu. For details, refer to
Information Pages on page 28. If the Demo
Print looks correct, the printer is printing
properly. Verify that the application and the
print driver selections are correct for your
print job.

The paper is damp.

Replace the paper.

The high-voltage supply
is defective.

For assistance, go to the Xerox® Support
website at
www.xerox.com/office/VLC400support.

Only one color is faded.

Toner cartridge is empty
or damaged.

Check the condition of the toner cartridge and
replace it if necessary.

Color around the edge of
printing is incorrect.

The color registration
is incorrect.

Adjust the color registration. For details, see
details, refer to Color Registration on
page 129.

Stray black dots or white areas
(dropouts).

The paper is outside the
recommended specification
range.

Replace the paper with a recommended size
and type, and confirm that your control panel
and print driver settings are correct. For
details, refer to Supported Paper on page 98.

There is debris on the rollers.

Wipe the feed rollers with a clean damp cloth
to remove debris from the rollers.

Note: Do not touch the transfer roller or the
exposed end of the transfer belt. Fingerprints
can cause print-quality issues.

The toner cartridges are not
Xerox® toner cartridges.

Ensure that the toner cartridges meet
specifications and replace them if necessary.
For details, refer to Consumables on

page 132.

e Vertical black or color streaks
or multiple colored streaks or
lines.

e Streaks in only one color.

The toner cartridges are not
Xerox® toner cartridges.

Ensure that the toner cartridges meet
specifications and replace them if necessary.
For details, refer to Consumables on

page 132.

Debris in the printer is dragging
against the toner before it
is fused.

Remove any debris or paper scraps from the
paper path under the rear cover.
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Probable Causes

There is a problem with the
toner cartridge for that color.

Troubleshooting

Solutions

Check the toner cartridge for damage and
replace if necessary. For assistance, go to the
Xerox® Support website at
www.xerox.com/office/VLC400support.

Partial blanks, creased paper, or
blotted printing.
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The paper is damp.

Replace the paper.

The paper is outside the
recommended specification
range.

Replace the paper with a recommended size
and type. For details, refer to Supported Paper
on page 98.

The printer is worn or damaged.

For assistance, go to the Xerox® Support
website at
www.xerox.com/office/VLC400support.

The toner cartridges are not
Xerox® toner cartridges.

Verify that the toner cartridges meet
specifications and replace if necessary. For
details, refer to Consumables on page 132.

The paper is impeded in the
paper path.

e Remove any paper or debris from the
paper path.

e Ensure that the trays are pushed in all
the way.

e Ensure that the rear cover is closed
and locked.

Condensation inside the printer
causes partial blanks or creased

paper.

Power on the printer and leave it on for at
least one hour to get rid of the condensation.
For assistance, go to the Xerox® Support
website at
www.xerox.com/office/VLC400support.

Vertical blanks appear.

The laser lenses are blocked.

Clean the laser lenses. For details, refer to
Cleaning the Laser Lenses.

The printer is worn or damaged.

For assistance, go to the Xerox® Support
website at
www.xerox.com/office/VLC400support.

The toner cartridges are not
Xerox® toner cartridges.

Ensure that the toner cartridges meet
specifications and replace if necessary.
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Troubleshooting

Symptom

White lines or streaks running
through only one color.

Probable Causes

Something is blocking the lens
for the affected color.

Solutions

Clean the lens for the affected color. For
details, refer to Cleaning the Laser Lenses.

White line or lines running
through all colors.

Paper or debris is dragging the
bottom of the transfer belt.

e Remove the paper or debris from
the printer.
e For assistance, go to the Xerox® Support

website at
www.xerox.com/office/VLC400support.

Slanted printing.
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The paper guides in the trays
are not set correctly.

Reset the paper tray guides. For details, refer
to Loading Paper on page 102.

Blotchy or mottled images.

The paper is too light or
too thin.

Choose a different paper type at the control
panel, in the application, and in the
print driver.

The paper is damp.

Replace the paper.

The humidity is too high.

Reduce the humidity in the room or move the
printer to a new location.
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Symptom

Spots or lines appear at regular
intervals on the prints.

c

Probable Causes

One or more of the components
in the paper path is marking
the paper.

Troubleshooting

Solutions

1.

Print the Repeating Defects pages.

At the control panel, touch Device >
Support > Support Pages >
Repeating Defects.

To determine the cause, measure the
distance between the print defects.

28 mm (1.1 in.) - Drum Cartridge
53 mm (2.1 in.) - Drum Cartridge
75 mm (3.0 in.) - Drum Cartridge
82 mm (3.2in.) - Fuser

95 mm (3.7 in.) - Fuser

25 mm (1.0 in.) - Transfer Belt
48 mm (1.9 in.) - Transfer Belt
57 mm (2.2 in.) - Transfer Belt
57 mm (2.2 in.) - Transfer Roller

If the repeating defects match one of
these distances, replace that item.
If the distance matches the Fuser or

Transfer Roller, call for service or replace
the Maintenance Kit.
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Troubleshooting

Getting Help

This section includes:

e Viewing Warning Messages on the CONtrol PANEL..........oeerirereneinessseeeseisessiesesssssssssssssssessenne 166
o Viewing Current Errors on the CONrol PANEL........veierieeeeeeesesiesssiestss st sssesssssssssssssssssssssssssssssssenns 166
e Using the Integrated TroubleShOOtiNG TOOLS.........ceerieererinetirresissssie s ssssesssssssssssssssssssssessenns 166
®  ONliNE SUPPOIT ASSISTANT ....cereeeriereeeeiseis et cesessssss s st ssssss s sssssssssss s ssssessssssessssssesssasssssssssssasesssssns 167
®  INFOIMOALION PUGES.....oiieeeeesetse sttt bss et sss st s s s st bas bbb s b b e s b ss s s s b ssss s assbsnsens 167
®  MOTE INTOMMIOTION oottt et es e et s e 167

Your printer comes with utilities and resources to help you troubleshoot printing problems.

Viewing Warning Messages on the Control Panel

When a warning condition occurs, the printer alerts you of the problem. A message appears on the
control panel and the LED status light on the control panel flashes amber or red. Warning alerts inform
you about printer conditions, such as low supplies or open doors, that require your attention. If more
than one warning condition occurs, only one warning message appears on the control panel at a time.

Viewing Current Errors on the Control Panel

When an error condition occurs, a message appears on the control panel to inform you of the problem.
Error messages warn you about printer conditions that prevent the printer from printing or degrade
printing performance. If more than one error occurs, only one is displayed on the control panel.

Using the Integrated Troubleshooting Tools

Your printer has a set of reports that you can print. These reports include the Demonstration Print page
and the Error History report that can assist you in troubleshooting certain problems. The Demonstration
Print page prints an image to show print quality. You can use this page to troubleshoot print quality
issues with the printer. The Error History report prints information on the most recent printer errors.

Printing Information Pages

1. At the printer control panel, press the Home button.
2. Touch Device > About > Information Pages.

3. To print an information page, touch the desired page.
4. Toreturn to the Home screen, press the Home button.
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Printing the Error History Report

1. At the printer control panel, press the Home button.
2. To print the Error History Report, touch Device > Support > Support Pages > Error History Report.
3. Toreturn to the Home screen, press the Home button.

Online Support Assistant

The Online Support Assistant is a knowledge base that provides instructions and troubleshooting help
to solve your printer problems. You can find solutions for print-quality problems, paper jams, software

installation issues, and more.

To access the Online Support Assistant, go to www.xerox.com/office/VLC400support.

Information Pages

Your printer has a set of information pages that you can print. These pages include configuration and
font information, demonstration pages, and more. For details, refer to Information Pages on page 28.

More Information

You can obtain more information about your printer from these sources:

Resource Location

Installation Guide

Packaged with the printer.

Other documentation for your printer

www.xerox.com/office/VLC400docs

Recommended Media List

United States: www.xerox.com/rmlna
European Union: www.xerox.com/rmleu

Technical support information for your printer;
including online technical support, Online Support
Assistant, and print driver downloads.

www.xerox.com/office/VLC400support

Information Pages

Print from the control panel. For details, refer to
Information Pages on page 28.

Order supplies for your printer

www.xerox.com/office/VLC400supplies

A resource for tools and information, including
interactive tutorials, printing templates, helpful tips,

and customized features to meet your individual needs.

www.xerox.com/office/businessresourcecenter

Local sales and Technical Customer Support

www.xerox.com/office/worldcontacts

Printer registration

www.xerox.com/office/register

Xerox® Direct online store

www.direct.xerox.com/
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Specifications

Printer Configurations and Options

Available Configurations

The printer is available in two configurations:
Network printer with USB or network connectivity.

Network printer with automatic 2-sided printing and USB or network connectivity.

Standard Features

Print Speed Standard and Enhanced modes up to 36 ppm (letter)/35 ppm (A4)
2-Sided Print Speed Standard and Enhanced modes up to 24 images per minute
Print Resolution e Standard mode: 600 x 600 x 1 bit dpi
e Enhanced mode: 600 x 600 x 8 bit dpi
Paper Capacity
e Bypass Tray e 150 sheets
e Tray1 e 550 sheets
e Optional 550-Sheet Feeder e 550 sheets
e Output Tray e 250 sheets
Maximum print size Legal (216 x 356 mm, 8.5 x 14in.)
2-Sided Printing Up to 163 g/m? from any tray
File Formats e JPEG
e TIFF
e PDF
e PDF/A
[ ] XPS
Control Panel 5-inch LCD touch screen with home and power/wake buttons
Connectivity e 2xUSB2.0 (TypeA)
e USB 3.0 (Type B)
e Ethernet TOBASE-T/100BASE-TX/1000BASE-T
e Wireless network connectivity with an IEEE802.11 n/g/b-compliant
Wireless Network Adapter (optional)
e Near Field Communication (NFC)
e AirPrint™
e Mopria™
Remote Access Embedded Web Server
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Options and Upgrades

e  Wireless network adapter

e 320 GB Hard Drive

e  550-Sheet Feeder

e Stand

e  External Card Reader/RFID Kit
e  Foreign Device Interface Kit
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Specifications

Physical Specifications

Weights and Dimensions

Standard Configuration Configuration with Optional 550-Sheet Feeder
Width 491 mm (19.3in.) 491 mm (19.3in.)
Depth 488 mm (19.2in.) 488 mm (19.2in.)
Height 533 mm (21 in.) 671 mm (26.4in.)
Weight 25.8 kg (56.9 lbs.) 28.4 kg (62.6 Ibs.)

Standard Configuration
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Total Space Requirements

Specifications

Standard Confirugation

Configuration with Optional 550-sheet Feeder

Width 991 mm (39in.) 991 mm (39in.)
Depth 1488 mm (58.6 in.) 1488 mm (58.6 in.)
Height 733 mm (28.9in.) 871 mm (34.3in.)

Clearance Requirements
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Environmental Specifications

Temperature

e  Operating Temperature Range: 10-32°C (50-90°F)
e  Optimal Temperature Range: 15-28°C (59-82°F)

Relative Humidity

e  Operating Humidity Range: 10-85 %
e  Optimal Humidity Range: 20-70 % relative humidity at 28°C (82°F)

Note: Under extreme environmental conditions, such as 10°C and 85 % relative humidity, printing
defects can occur due to condensation inside the printer.

Elevation

For optimum performance, use the printer at elevations below 3100 m (10,170 ft.).
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Specifications

Electrical Specifications

Power Supply Voltage and Frequency

Power Supply Voltage Frequency Current Required
110-127 VAC +/-10 % 60 Hz +/-3 Hz 10A
(99-140 VAQ)
220-240 VAC +/-10 % 50 Hz +/-3 Hz 6A
(198-264 VAQC)

Power Consumption

e Sleep mode: <4 W

e Low Power mode: 14 W
e Standby: 76 W

e  Continus printing: 705 W

ENERGY STAR Qualified Product

The following configuration of this device is ENERGY STAR® qualified under the
ENERGY STAR Program Requirements for Imaging Equipment:

Network printer with automatic 2-sided printing and USB or network connectivity.

The ENERGY STAR Imaging Equipment Program is a team effort between United
States, European Union, and Japanese governments and the office equipment
industry to promote energy-efficient copiers, printers, fax, multifunction printers,
personal computers, and monitors. Reducing product energy consumption helps
combat smog, acid rain, and long-term changes to the climate by decreasing the
emissions that result from generating electricity.

ENERGY STAR settings are preset on Xerox® equipment at the factory to switch to Power Saver modes
after 10 minutes from the last copy or print.
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Specifications

Germany - Blue Angel

RAL, the German Institute for Quality Assurance and Labeling, has awarded the
following configuration of this device the Blue Angel Environmental Label:

Network printer with automatic 2-sided printing and USB or network connectivity.

This label distinguishes it as a device that satisfies Blue Angel criteria for
environmental acceptability in terms of device design, manufacture, and operation.
For more information, go to www.blauer-engel.de.

Recycling Supplies

If you want to return used supplies for recycling, follow the instructions included with the new supplies.
If the instructions or shipping label are not available, for more information, go to www.xerox.com/gwa

for more information.
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Specifications

Performance Specifications

Feature Specifications

Printer warm-up time Power on: as fast as 60 seconds.
Recovery from sleep mode as fast as 4 seconds.

Note: Warm-up time assumes an ambient temperature of 20°C (68°F)
at 65 % relative humidity.

Print Speed

Print speeds for continuous printing are up to 36 ppm. Print speeds are the same for color or black and
white printing.

Several factors affect print speed:
e Print mode: The fastest print mode is Standard.

e  Papersize: Letter (8.5 x 11 in.) prints slightly faster than A4 (210 x 297 mm). Larger sizes reduce
print speeds.

e Paper type and weights: For faster printing, use paper weights of 105 g/m? or less.

Maximum Print Speeds:

e 1-sided printing: 36 ppm on Letter-sized paper and 35 ppm on A4 paper

e  2-sided printing: 24 images per minute on Letter-sized paper and on A4 paper
e  Heavyweight Paper: 18 ppm
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Regulatory Information

This appendix includes:

Basic Regulations

Copy Regulations
Safety Certification
Material Safety Data Sheets
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Regulatory Information

Basic Regulations

Xerox has tested this printer to electromagnetic emission and immunity standards. These standards are
designed to mitigate interference caused or received by this printer in a typical office environment.

United States FCC Regulations

This equipment has been tested and found to comply with the limits for a Class A digital device,
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference when the equipment is operated in a commercial environment. This equipment
generates, uses, and can radiate radio frequency energy. If the equipment is not installed and used

in accordance with these instructions, it can cause harmful interference to radio communications.
Operation of this equipment in a residential area is likely to cause harmful interference. Users are
required to correct the interference at their own expense.

If this equipment does cause harmful interference to radio or television reception, which can be
determined by turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

e Reorient or relocate the receiving antenna.
e Increase the separation between the equipment and receiver.

e  Connect the equipment into an outlet on a circuit different from that to which the receiver
is connected.

Consult the dealer or an experienced radio/TV technician for help.

Changes or modifications to this equipment not approved by Xerox can void the authority of the user
to operate this equipment.

_;i"»._ WARNING: To ensure compliance with Part 15 of the FCC rules, use shielded interface cables.

Canada
This Class A digital apparatus complies with Canadian ICES-003.

Cet appareil numeérique de la classe A est conforme @ la norme NMB-003 du Canada.
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Certifications in Europe

The CE mark applied to this product symbolizes a declaration of conformity by Xerox
c € with the following applicable Directives of the European Union as of the dates indicated:

o February 26, 2014: Low Voltage Directive 2014/35/EU
o  February 26, 2014: Electromagnetic Compatibility Directive 2014/30/EU

e  March 9, 1999: Radio & Telecommunications Terminal Equipment Directive
1999/5/EC

This printer, if used properly in accordance with the instructions, is not dangerous for the consumer or
for the environment.

A signed copy of the Declaration of Conformity for this printer can be obtained from Xerox.

/N WARNINGS:
e Changes or modifications to this equipment not specifically approved by the
Xerox Corporation may void the user's authority to operate this equipment.

e External radiation from Industrial, Scientific, and Medical (ISM) equipment
can interfere with the operation of this Xerox device. If external radiation from
ISM equipment interferes with this device, contact your Xerox representative
for assistance.

e Thisis aclass A product. In a domestic environment, this product can cause
radio frequency interference, in which case the user can be required to take
adequate measures.

e To ensure compliance with European Union regulations, use shielded
interface cables.

European Union Lot 4 Imaging Equipment Agreement
Environmental Information

Environmental Information Providing Environmental Solutions and Reducing Cost

The following information has been developed to assist users and has been issued in relation to the
European Union (EU) Energy Related Products Directive, specifically the Lot 4 study on Imaging
Equipment. This requires manufacturers to improve environmental performance of in scope products
and supports the EU action plan on energy efficiency.

In scope products are Household and Office equipment that meet the following criteria.
e Standard monochrome format products with a maximum speed less than 66 A4 images per minute
e Standard color format products with a maximum speed less than 51 A4 images per minute
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Environmental Benefits of Duplex Printing

Most Xerox products have duplex printing, also known as 2-sided printing, capability. This enables you
to print on both sides of the paper automatically, and therefore helps to reduce the use of valuable
resources by reducing your paper consumption. The Lot 4 Imaging Equipment agreement requires that
on models greater than or equal to 40 ppm color or greater than or equal to 45 ppm monochrome the
duplex function has been auto enabled, during the setup and driver installation. Some Xerox models
below these speed bands may also be enabled with 2-sided printing settings defaulted on at the time
of install. Continuing to use the duplex function will reduce the environmental impact of your work.
However, should you require simplex/1-sided printing, you may change the print settings in the

print driver.

Paper Types

This product can be used to print on both recycled and virgin paper, approved to an environmental
stewardship scheme, which complies with EN12281 or a similar quality standard. Lighter weight paper
(60 g/m?), which contains less raw material and thus save resources per print, may be used in certain
applications. We encourage you to check if this is suitable for your printing needs.

ENERGY STAR

The ENERGY STAR program is a voluntary scheme to promote the development and
purchase of energy efficient models, which help to reduce environmental impact.
Details on the ENERGY STAR program and models qualified to ENERGY STAR can be
found at the following website:
www.energystar.gov/index.cfm?fuseaction=find_a_product.showProductGroup&pgw_
code=IEQ

The ENERGY STAR and ENERGY STAR mark are registered United States trademarks.

The ENERGY STAR Imaging Equipment Program is a team effort between United
States, European Union, and Japanese governments and the office equipment
industry to promote energy-efficient copiers, printers, fax, multifunction printers,
personal computers, and monitors. Reducing product energy consumption helps
combat smog, acid rain, and long-term changes to the climate by decreasing the
emissions that result from generating electricity.

Power Consumption and Activation Time

The amount of electricity that a device consumes depends on the way the device is used. This device is
designed and configured to enable you to reduce your electricity usage.

Power Saver modes are enabled on your device to reduce energy consumption. After the last print, the
device transitions to Ready mode. In this mode, the device can print again immediately. If the device is
not used for a specified period, the device transitions to Low Power mode, then to Sleep mode. In these
modes, to enable reduced-power consumption, only essential functions remain active. The device takes
longer to produce the first print after it exits the Power Saver modes than it takes to print in Ready
mode. This delay is the result of the system waking up and is typical of most imaging devices on

the market.
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Regulatory Information

To save power, you can enable Auto Power Off mode on your device. If Auto Power Off mode is enabled,
you can configure the mode as follows:

e Always Allowed: The device powers off automatically after the specified time, and the cumulative
Low Power mode and Sleep mode timeouts have elapsed.

e Allowed ONLY When Conditions are Met: The device automatically powers off only after timeouts
have elapsed. The device also powers off if Fax, USB Drive, and Wired and Non-Wired Network have
not been activated.

To change the Power Saver settings, refer to the User Guide at www.xerox.com/office/VLCA400docs.
For further assistance, contact your System Administrator or refer to the System Administrator Guide.

To enable Auto Power Off mode, contact your System Administrator. For details, refer to the System
Administrator Guide at www.xerox.com/office/VLC400docs.

To learn more about Xerox participation in sustainability initiatives, go to:
www.xerox.com/about-xerox/environment/enus.html.

Note: Changing the default Power Saver activation times can result in an overall higher energy
consumption of the device. Before you turn off Power Saver modes or set a long activation time,
consider the increase in device power consumption.

Default Power Saver Settings

This device is ENERGY STAR®-qualified under the ENERGY STAR Program Requirements for Imaging
Equipment. The transition time from Ready mode to Low-Power mode can be set up to 60 minutes.
The default value is 10 minutes. The transition time from Low-Power mode to Sleep mode can be set
up to 60 minutes. The default value is set at 1 minute. The total transition time from Ready mode to
Sleep mode can take up to 60 minutes.

To change the Power Saver settings, contact your system administrator or refer to System Administrator
Guide at www.xerox.com/office/VLC400docs.

Environmental Choice Certified to Office Machines CCD-035

e This product is certified to Environmental Choice standard for office
£ % machines, meeting all requirements for reduced environmental impact.
:;s & As part of achieving certification, Xerox Corporation has proven this product

2
%

meets the Environmental Choice criteria for energy efficiency. Certified
copier, printer, multifunctional device, and fax products must also meet
criteria such as reduced chemical emissions and demonstrate compatibility
with recycled supplies. Environmental Choice was established in 1988 to help
consumers find products and services with reduced environmental impacts.
Environmental Choice is a voluntary, multi-attribute, and lifecycle-based
environmental certification. This certification indicates that a product has
undergone rigorous scientific testing, exhaustive auditing, or both, to prove its
compliance with stringent, third-party, environmental performance standards.

0, I
Vagnrsy
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Regulatory Information

Germany

Germany - Blue Angel

RAL, the German Institute for Quality Assurance and Labeling, has awarded
this device the Blue Angel Environmental Label. This label distinguishes it as a
device that satisfies Blue Angel criteria for environmental acceptability in terms
of device design, manufacture, and operation. For more information, go to:
www.blauer-engel.de.

Blendschutz

Das Gerdt ist nicht fur die Benutzung im unmittelbaren Gesichtsfeld am Bildschirmarbeitsplatz
vorgesehen. Um storende Reflexionen am Bildschirmarbeitsplatz zu vermeiden, darf dieses Produkt
nicht im unmittelbaren Gesichtsfeld platziert werden.

Larmemission

Maschinenldrminformations-Verordnung 3. GPSGV: Der hochste Schalldruckpegel betragt 70 dB(A) oder
weniger gemdf EN ISO 7779.

Importeur
Xerox GmbH
HellersbergstraBe 2-4
41460 Neuss

Deutschland

Turkey RoHS Regulation
In compliance with Article 7 (d), we hereby certify “it is in compliance with the EEE regulation.”

“EEE yonetmeligine uygundur.”

Eurasian Economic Community Certification

union, the Eurasian Economic Community, or EurAseC. The Eurasian Economic
Community members anticipate sharing a common regulatory scheme and

[ H [ Russia, Belarus, and Kazakhstan are working to establish a common customs
common EurAsEC certification mark, the EAC Mark.
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Regulatory Information

Regulatory Information for 2.4 GHz Wireless Network Adapter

This product contains a 2.4 GHz Wireless LAN radio transmitter module which complies with the
requirements specified in FCC Part 15, Industry Canada RSS-210 and European Council
Directive 99/5/EC.

Operation of this device is subject to the following two conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any interference received, including interference that may
cause undesired operation.

Changes or modifications to this device not specifically approved by the Xerox Corporation may void the
user's authority to operate this equipment.

Ozone Release

This printer produces ozone during normal operation. The amount of ozone produced is dependent on
copy volume. Ozone is heavier than air and is not produced in amounts large enough to harm anyone.
Install the printer in a well-ventilated room.

For more information in the United States and Canada, go to www.xerox.com/environment. In other
markets, please contact your local Xerox representative or go to www.xerox.com/environment_europe.
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Regulatory Information

Copy Regulations

United States

Congress, by statute, has forbidden the reproduction of the following subjects under certain
circumstances. Penalties of fine or imprisonment may be imposed on those guilty of making
such reproductions.

1. Obligations or Securities of the United States Government, such as:
—  Certificates of Indebtedness.
—  National Bank Currency.
—  Coupons from Bonds.
—  Federal Reserve Bank Notes.
—  Silver Certificates.
—  Gold Certificates.
—  United States Bonds.
—  Treasury Notes.
—  Federal Reserve Notes.
—  Fractional Notes.
—  Certificates of Deposit.
—  Paper Money.
— Bonds and Obligations of certain agencies of the government, such as FHA and so on.

— Bonds. United States Savings Bonds may be photographed only for publicity purposes in
connection with the campaign for the sale of such bonds.

— Internal Revenue Stamps. If it is necessary to reproduce a legal document on which there is
a canceled revenue stamp, this may be done provided the reproduction of the document is
performed for lawful purposes.

—  Postage Stamps, canceled or uncanceled. For philatelic purposes, Postage Stamps may be
photographed, provided the reproduction is in black and white and is less than 75 % or more
than 150 % of the linear dimensions of the original.

—  Postal Money Orders.
—  Bills, Checks, or Drafts of money drawn by or upon authorized officers of the United States.

—  Stamps and other representatives of value, of whatever denomination, which have been or
may be issued under any Act of Congress.
— Adjusted Compensation Certificates for Veterans of the World Wars.
2. Obligations or Securities of any Foreign Government, Bank, or Corporation.
3. Copyrighted materials, unless permission of the copyright owner has been obtained or the
reproduction falls within the “fair use” or library reproduction rights provisions of the copyright law.

Further information of these provisions may be obtained from the Copyright Office, Library of
Congress, Washington, D.C. 20559. Ask for Circular R21.
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4. Certificate of Citizenship or Naturalization. Foreign Naturalization Certificates may be
photographed.

©® No W

Passports. Foreign Passports may be photographed.

Immigration papers.

Draft Registration Cards.

Selective Service Induction papers that bear any of the following Registrant’s information:

Earnings or Income.

Court Record.

Physical or mental condition.

Dependency Status.

Previous military service.

Exception: United States military discharge certificates may be photographed.

9. Badges, Identification Cards, Passes, or Insignia carried by military personnel, or by members of the
various Federal Departments, such as FBI, Treasure, and so on (unless photograph is ordered by the
head of such department or bureau).

Reproducing the following is also prohibited in certain states:

e  Automobile Licenses.

) Drivers’ Licenses.

e Automobile Certificates of Title.

The preceding list is not all inclusive, and no liability is assumed for its completeness or accuracy.
In case of doubt, consult your attorney.

For more information about these provisions contact the Copyright Office, Library of Congress,
Washington, D.C. 20559. Ask for Circular R21.

Xerox® VersalLink® C400 Color Printer 187
User Guide



Regulatory Information

Canada

Parliament, by stature, has forbidden the reproduction of the following subjects under certain
circumstances. Penalties of fine or imprisonment may be imposed on those guilty of making such
reproductions.

Current bank notes or current paper money

Obligations or securities of a government or bank

Exchequer bill paper or revenue paper

The public seal of Canada or of a province, or the seal of a public body or authority in Canada, or of
a court of law

Proclamations, orders, regulations, or appointments, or notices thereof (with intent to falsely cause
same to purport to have been printed by the Queens Printer for Canada, or the equivalent printer
for a province)

Marks, brands, seals, wrappers, or designs used by or on behalf of the Government of Canada or of
a province, the government of a state other than Canada or a department, board, Commission, or
agency established by the Government of Canada or of a province or of a government of a state
other than Canada

Impressed or adhesive stamps used for the purpose of revenue by the Government of Canada or of
a province or by the government of a state other than Canada

Documents, registers, or records kept by public officials charged with the duty of making or issuing
certified copies thereof, where the copy falsely purports to be a certified copy thereof

Copyrighted material or trademarks of any manner or kind without the consent of the copyright or
trademark owner

This list is provided for your convenience and assistance, but it is not all-inclusive, and no liability is
assumed for its completeness or accuracy. In case of doubt, consult your solicitor.

Other Countries

Copying certain documents may be illegal in your country. Penalties of fine or imprisonment may be
imposed on those found guilty of making such reproductions.

Currency notes

Bank notes and checks

Bank and government bonds and securities

Passports and identification cards

Copyright material or trademarks without the consent of the owner
Postage stamps and other negotiable instruments

This list is not inclusive and no liability is assumed for either its completeness or accuracy. In case of
doubt, contact your legal counsel.
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Safety Certification

This device is certified by the following Agencies using the following safety standards.

Agency Standard

Underwriters Laboratories Inc. (US/Canada) UL 60950-1, 2nd Edition, 2014-10-14
CAN/CSA C22.2 No. 60950-1-07, 2nd Edition, 2014-10

Underwriters Laboratories Inc. (Europe) IEC 60950-1:2005 + A1:2009 + A2:2013
EN 60950-1:2006 + A11:2009 + A1:2010 + A12:2011 + A2:2013
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Material Safety Data Sheets

For Material Safety Data information regarding your printer, go to:
e  North America: www.xerox.com/msds
e  European Union: www.xerox.com/environment_europe

For the Customer Support Center phone numbers, go to www.xerox.com/office/worldcontacts.
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Recycling and Disposal
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Recycling and Disposal

All Countries

If you are managing the disposal of your Xerox product, please note that the printer may contain lead,
mercury, perchlorate, and other materials whose disposal may be regulated due to environmental
considerations. The presence of these materials is fully consistent with global regulations applicable

at the time that the product was placed on the market. For recycling and disposal information, contact
your local authorities. Perchlorate Material: This product may contain one or more Perchlorate-
containing devices, such as batteries. Special handling may apply. For more information, go to
www.dtsc.ca.gov/hazardouswaste/perchlorate.
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Recycling and Disposal

North America

Xerox operates an equipment take-back and reuse/recycle program. Contact your Xerox representative
(1-800-ASK-XEROX) to determine if this Xerox product is part of the program. For more information
about Xerox environmental programs, visit www.xerox.com/environment, or for recycling and disposal
information, contact your local authorities.
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Recycling and Disposal

European Union

Some equipment may be used in both a domestic/household and a professional/business application.

Domestic/Household Environment

Application of this symbol on your equipment is confirmation that you should
not dispose of the equipment in the normal household waste stream.

In accordance with European legislation, end of life electrical and electronic equipment subject to
disposal must be segregated from household waste.

Private households within EU member states may return used electrical and electronic equipment
to designated collection facilities free of charge. Please contact your local disposal authority
for information.

In some member states, when you purchase new equipment, your local retailer may be required to
take back your old equipment free of charge. Please ask your retailer for information.

Professional/Business Environment

Application of this symbol on your equipment is confirmation that you must
dispose of this equipment in compliance with agreed national procedures.

In accordance with European legislation, end of life electrical and electronic equipment subject to
disposal must be managed within agreed procedures.

Prior to disposal, please contact your local reseller or Xerox representative for end of life
take-back information.
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Collection and Disposal of Equipment and Batteries

These symbols on the products and/or accompanying documents mean that used
electrical and electronic products and batteries should not be mixed with general
household waste.

For proper treatment, recovery, and recycling of old products and used batteries,
please take them to applicable collection points, in accordance with your national
legislation and the Directive 2002/96/EC and 2006/66/EC.

By disposing of these products and batteries correctly, you will help to save valuable
resources and prevent any potential negative effects on human health and the
environment which could otherwise arise from inappropriate waste handling.

For more information about collection and recycling of old products and batteries,
please contact your local municipality, your waste disposal service or the point of
sale where you purchased the items.

Penalties may be applicable for incorrect disposal of this waste, in accordance with
national legislation.

Business Users in the European Union

If you wish to discard electrical and electronic equipment, please contact your dealer or supplier for
further information.

Disposal Outside of the European Union

These symbols are only valid in the European Union. If you wish to discard these items, please contact
your local authorities or dealer and ask for the correct method of disposal.

Battery Symbol Note

This wheeled bin symbol may be used in combination with a chemical symbol.
This establishes compliance with the requirements set out by the Directive.

Hg

Battery Removal

Batteries should only be replaced by a manufacturer-approved service facility.
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Recycling and Disposal

Other Countries

Please contact your local waste management authority to request disposal guidance.
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